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INFORMATION TECHNOLOGY
LEVEL 2 - WHAT YOU NEED TO KNOW
PART A
In searching for and selecting information,
You need to know how to:

In presenting information
You need to know how to:

•

Identify suitable sources of information (eg
hand-written documents, material to be
scanned, files on disks, CD-ROMs,
databases, the Internet);

•

•

Search for information using multiple
criteria (eg operators such as ‘and’,
‘greater than’ and tools such as search
engines);

Select and use appropriate layouts for
presenting combined information (eg
document structures such as margins,
columns and headings, borders for images
and text, record structures, tables,
spreadsheets);

•

Present information in a consistent way,
(eg paragraph layouts, size and styles of
images and text, alignments, fonts);

•

Develop the presentation to suit your
purpose and types of information,
including text, images and numbers, (eg
highlight information to improve its impact,
refine layouts, make sure it suits the needs
of your audience);

•

Ensure your work is accurate and clear (eg
proof-read, use a spell-checker, seek the
views of others) and is saved appropriately
(eg use suitable folders/directories and file
names, avoid loss).

•

Interpret information and decide what is
relevant to your purpose (eg to respond to
an enquiry, write a project report, help
solve a problem, design or make
something).

In developing information,
You need to know how to:
•

Enter and bring together information (eg
‘copy and paste’ or import text, images,
numbers), using formats that help
development (eg using tabs rather than
spaces to align text, using tables or
frames to position information);

•

Explore information as needed for your
purpose (eg follow lines of enquiry, explore
the effects of changing information in a
spreadsheet model to make and test
predictions);

•

Develop information in the form of text,
images and numbers (eg link information,
organise information under headings,
restructure tables, and graphs from data,
select records or fields and prepare
reports from a database);

•

Derive new information (eg compare
information from different sources to reach
a conclusion, use formulae to calculate
information such as a total or average).

 Grimsby College
Key Skills – Intro
Information Technology – Level 2 Specifications

You will also need to know: the benefits and
disadvantages of using IT; when it is
necessary
to
observe
copyright
or
confidentiality; how to identify errors and their
causes and minimise risks from viruses; and
how to work safely and minimise health risks.
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INFORMATION TECHNOLOGY - LEVEL 2 - PART B
ACHIEVEMENT RECORD
Course/
Programme

IT
2.1

IT
2.2

Student
Name

You must:

Evidence must show you can:

Search for and
select
information for
two different
purposes.

• Identify the information you
need and suitable sources;

Explore and
develop
information,
and derive new
information, for
two different
purposes.

• Enter and bring together
information using formats that
help development;
• Explore information as needed
for your purpose; and
• Develop information and
derive new information as
appropriate.
• Select and use appropriate
layouts for presenting
combined information in a
consistent way;
• Develop the presentation to
suit your purpose and the
types of information; and
• Ensure your work is accurate,
clear and saved appropriately.

IT
2.3

Portfolio
reference/
code

Evidence
Type
1-9

Assessor
Initials

• Carry out effective searches;
and
• Select information that is
relevant to your purpose.

Present
combined
information for
two different
purposes.
Your work must
include at least
one example of
text, one
example of
images and
one example of
numbers.
INTERNAL VERIFICATION

Name

Signature

Date

KEY: Type of Evidence Sampled –
1. Naturalistic observation of workplace
activities

4. Candidates explanation of process/personal
account

2. Observation of product

5. Simulation/roleplay

8. Oral questioning

3. Testimony of others

6. Assessment of prior achievement

9. Written questioning
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7. Projects/assignments/case studies

Date

INFORMATION TECHNOLOGY
LEVEL 2 – GUIDANCE
PART C
Examples of activities you might use

Examples of Evidence

You will have opportunities to develop and
apply your IT skills during your work, studies or
other activities. For example when:

2.1

Search for and select information

•

Researching and reporting findings from a
project or assignment;

Print-outs of the relevant information with
notes of sources and how you made searches,
or a record from an assessor who observed
you using IT when searching for information.

•

Researching and designing a product;

2.2

•

Dealing with enquiries from customers or
clients;

•

Exchanging information and ideas with
work colleagues or other students.

Print-outs or a record from an assessor who
observed you using IT, with notes to show how
you explored and developed information and
derived new information.

You will need time to practise your skills and
prepare for assessment. So it is important to
plan ahead.
The purpose for using IT can be decided by
you or by other people, but you must make
sure that the work you produce suits this
purpose. Using IT can contribute evidence for
other key skills, such as communication and
application of number.
You will need to think about the quality of your
IT skills and check your evidence covers all the
requirements in Part B.

2.3

Develop information

Present information

Working drafts, or a record from an assessor
who observed your screen displays, with notes
to show how you have developed content and
presentation.
Print-outs, or prints of static or dynamic screen
displays, of your final work, including examples
of text, images and numbers.
Records of how you saved information.
If producing certain types of evidence creates
difficulties, due to disability or other factors,
your may be able to use other ways to show
your achievement.
Ask your tutor or superviser for further
information.
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Level 2 - Contents
Section 1
P1 - P12
P13 - P15

-

Internet Searching
Build-up Exercise: Scanner Use

Section 2
P16 - P36
P37 - P41
P42 - P50
P51 - P55

-

Graphics
Graphical ‘Representation Of Data’ Software
Creating Graphs And Charts
Modifying Graphs And Charts

Section 3
P56 - P57 P58 - P67 P68 - P95 P96 - P97 P98 - P101 P102-P105 P106-P109 P110 - P116 P117 - P121 -
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What Is A Spreadsheet?
Getting Help With Excel
Excel ‘97
English Law
A Guide To Copyrights
Data Protection Acts
Computer Viruses
Working With VDU’s
RSI

KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
GETTING STARTED ON THE WEB
Whether you're brand new to browsing the World Wide Web or you have some experience under your belt,
you'll want to check out the practical questions and answers and loads of useful browser tips in this
section.
WHAT'S IN A WEB BROWSER?
A Web browser contains the basic software you need in order to find, retrieve, view, and send information
over the Internet. This includes software that lets you:
•
•
•

Send and receive electronic mail (or e-mail) messages worldwide nearly instantaneously.
Read messages from newsgroups (or forums) about thousands of topics in which users share
information and opinions.
Browse the World Wide Web (or Web) where you can find a rich variety of text, graphics, and
interactive information.

Browsers such as Internet Explorer 5.0 include additional Internet-related software.
For example, with Internet Explorer version 5.0, you also get:
•
•
•
•
•
•
•

™

Windows Media Player version 6.0
NetMeeting® conferencing software version 2.11
ActiveX® controls
Chat version 2.5
®
DirectShow application programming interface
Subscriptions for automatic Web page update
Dynamic hypertext mark-up language (HTML)

You also can download various Microsoft software programs—like Active Channel a Webcast or the 128bit encryption program—that work with Internet Explorer 5.0 or use the install-on-demand feature that
effortlessly downloads software called for on other Web sites.
•

Windows Media Player – This allows you to see and hear live and recorded broadcasts—such as
concerts or breaking news with synchronised audio, graphics, video, uniform resource locators (URLs),
and script commands. And streaming technology allows you to see or hear the information as it arrives
instead of having to wait for the entire file to download.

•

NetMeeting conferencing software – With a sound card, speakers, and a microphone, you can talk
to others worldwide from family to colleagues using NetMeeting. Add a Windows-compatible video
capture card and/or camera to see them, too. Exchange pictures and draw diagrams on an electronic
whiteboard, communicate with text-based chat, transfer files, and share applications.

•

ActiveX controls – ActiveX technology (first developed for Internet Explorer 3.0) allows authors to
develop innovative, highly interactive Web sites. ActiveX controls are the software components that
run behind the scenes in Internet Explorer so that these sites come alive for you.

•

Chat – This program lets you converse online in real time with one or more people. You decide how
your message is displayed—text only or text with graphics. You can send and receive sounds, files,
and links of e-mail addresses, Web pages, and newsgroups. You can even "whisper" to another
person in a group chat. Use it for your next online family reunion.

•

DirectShow application programming interface – DirectShow allows you to experience televisionquality video and CD-quality audio, while minimising file size and download time compared with other
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video and audio formats. By using "progressive downloading," DirectShow lets you start playing an
audio or video clip while it's still downloading.

Subscriptions – This feature delivers preferred information straight to your desktop, when you want it, in
the way you want it—for free (Internet connect charges may apply). To subscribe to a Web site, select the
site and specify when you want the information updated and how you want to be notified, such as through
an e-mail message. Internet Explorer does the rest. Then you can browse the content offline.
Dynamic HTML – Internet Explorer 5.0 supports this programming language, which makes enticing,
unique, fun and fast-downloading Web pages possible. The pages download quickly because they are
created using lightweight HTML instead of heavy-duty graphics. Round-trips to the server are minimised,
which means faster browser performance on your desktop computer.

DOWNLOAD INTERNET EXPLORER 5.0
Simplicity, speed, and manageability all contributed to the unprecedented success of Internet Explorer 5.0
during testing, and now it's available for users everywhere. Internet Explorer 5.0 is fast and saves you time
on the Web by automating complex tasks and making you more productive. It's never been easier to get
online, find the information you need, and just move faster.
Check out the Internet Explorer 5 Web site to learn more about the exciting innovations of Internet Explorer
5.0. If you don't have version 5.0, you can download it from this site.
If you don't have a Web browser, contact your Internet service provider (ISP) to find out how to connect to
the Internet in order to download a Web browser.

WHAT IS A URL?

A URL (or uniform resource locator) is the address of an Internet file. Usually it consists of four parts:
protocol, server (or domain), path, and filename. Sometimes there's no path or filename. Here's an
example:
•

http://www.microsoft.com/windows/default.asp
• http is the protocol
• www.microsoft.com is the server
• windows/ is the path
• default.asp is the filename
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BROWSER TIPS
Use the following tips to take advantage of all the great features of Internet Explorer 5.0.
Spot the links.
You can tell whether an item on a page is a link by moving the mouse pointer over the item. If the pointer
changes to a hand, then the item is a link. A link can be a picture, a three-dimensional image, or coloured
text. Click any link on a Web page to go to another page within that site or another site.
Display all Web pages faster
1.
2.
3.
4.
5.

On the Tools menu in the browser, click Internet Options.
Click the Advanced tab.
In the Multimedia area, clear one or more of the Show pictures, Play animations, Play videos, or
Play sounds check boxes.
If the Show pictures or Play videos check box is cleared, you can still display an individual picture or
animation on a Web page by right-clicking its icon and then clicking Show Picture.
If the pictures on the current page are still visible after you clear the Show pictures check box, you
can hide them by clicking the View menu and then clicking Refresh.

Display previously viewed pages faster
1.
2.
3.
4.

On the Tools menu in the browser, click Internet Options.
On the General tab, click Settings.
To create more space to store pages temporarily, move the slider to the right.
To prevent Internet Explorer from updating pages in the Temporary Internet Files folder, click never.

Change how page colours are displayed
1.
2.

On the Tools menu in the browser, click Internet Options.
Change the settings as needed.

Display text in a different font
1.
2.
3.

On the Tools menu in the browser, click Internet Options.
On the General tab, click Fonts.
In the Proportional and Fixed-width font lists, click the fonts you want.

Specify which font and colour setting to always use
1.
2.
3.

On the Tools menu in the browser, click Internet Options.
On the General tab, click Accessibility.
Change the settings as needed.

Display text larger or smaller
On the View menu, point to Fonts, and then click the size you want.
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View Web pages in a different language
Some Web sites offer their content in several languages. You can add languages to your list of languages
in Internet Explorer so that you can view these sites in your preferred language. To view Web pages
written in a different language:
1.
2.
3.
4.

On the Tools menu in the browser, click Internet Options.
On the General tab, click Languages.
Click Add.
Select the language you want to add.
• If you speak several languages, you can arrange them in order of priority. If a Web site offers
multiple languages, it will supply content in the language with the highest priority.
• Adding languages does not guarantee that you have a font that can display Web pages in your
preferred languages. You may need to download a Multilanguage support pack to display pages in
these languages. To download Multilanguage support packs, see the Internet Explorer download
page.

Add a page to your Favourites
1.
2.
3.

Go to the page that you want to add to your collection of favourite pages.
On the Favourites menu, click Add to Favourites.
Type a new name for the page if you want to.
• To open one of your favourite pages, click the Favourites button on the toolbar and then click the
page you want to open.
• To keep track of your favourite pages, you can organise them into folders. Click the Create In
button in the Add to Favourites dialog box.

Add Microsoft Product Insider to your Favourites
To make sure you always have access to the latest Internet news, software updates, and tips and tricks for
®
using Internet Explorer and other Microsoft products, why not add the Microsoft Product Insider site to
your Favourites list now? To add Product Insider to your Favourites list, follow these steps:
1.
2.
3.
4.
5.

On the File menu of your Internet Explorer toolbar, point to New and click Window so you don't lose
your place in this guide.
On the File menu in the new window, click Open, and then type http://www.microsoft.com/insider/
in the address box.
Click OK.
®
When the Microsoft products Insider home page has finished loading, on the Favourites menu, click
Add to Favourites, and click OK.
Close the new window.

Organise your Favourites into folders
1.
2.
3.

On the Favourites menu, click Organise Favourites.
Click Create New Folder, type a name for the folder, and then press ENTER.
Drag the shortcuts in the list to the appropriate folders.
• You might want to organise your pages by topic. For example, you could create a folder named Art
for storing information about art exhibits and reviews.
• If the number of shortcuts or folders makes dragging impractical, you can use the Move button
instead.

Find Favourites more quickly in an overloaded Favourites menu
1.
2.
3.

On the Windows Start menu, point to Find and click Files or Folders. Windows will display a Find:
All Files dialog box.
In the Look in dropdown box, type c:\windows\favorites, or browse to this directory.
In the Named dropdown box, type the filename you are looking for and click the Find Now button.
Windows will display all the Favourites that match your query and list information about each.
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4.

If there are multiple results, you can click the column information title and sort the results by name,
date, and so on.

Edit Favourites.
You can do a lot more with your Favourites folder list in Internet Explorer 5.0 than you can with other
browsers. Remember these tips:
•
•
•
•

You can drag a Favourite or folder to different areas to reorganise.
You can drag a Favourite or folder from the list box to your desktop.
Right-click a Favourite or folder to display a pop-up menu that lets you perform functions like Edit (in
the Microsoft FrontPage® Web site creation and management tool), Subscribe, Copy, and Delete.
You can click the Send To option to send the Favourite to a floppy disk, create a shortcut on the
desktop, or attach the shortcut to an e-mail message.

To Change your home page.
1.
2.
3.
4.

Go to the page that you want to appear when you first start Internet Explorer.
On the Tools menu, click Internet Options.
Click the General tab.
In the Home Page area, click Use Current.

To restore your original home page, click Use Default.
Save text and graphics from the Web.
When you see text or graphics on a Web page that you like or want to refer to later, you can save them on
your computer's hard disk. Later, you can open the saved file and review it offline.
To save a text or source file:
1.
2.

On the toolbar, click File, and then click Save As.
Click Save to save the file.

To save a graphic:
1.
2.
3.
4.

Right-click the graphic.
On the shortcut menu that appears, click Save Picture As.
Browse to the folder where you would like to save the file.
Click Save to save the file.

To open a saved file, double-click it from the folder where you've saved it. Internet Explorer will start
automatically, and your saved file will appear in the browser window.
To add a page to your Links bar
•
•
•

Drag the icon for the page from your Address bar to your Links bar.
Drag a link from a Web page to your Links bar.
Drag a link to the Links folder in your Favourites list. You can drag it directly to the Favourites menu
and then into the Links folder or you can drag it to the Links folder when displaying your Favourites in
the Explorer bar.

You also can organise your links by dragging them to a different location on the Links bar.
Create a desktop shortcut to the current page.
Right-click the page, and then click Create Shortcut. If the Internet Explorer window is not maximised, you
also can create a shortcut by dragging a link from the Internet Explorer window to the location you want,
such as your desktop or a folder.
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Return to a Web page you've already seen.
There are several ways to return to a previously viewed Web page:
•
•
•
•

To return to the last page you viewed, you can click the Back button on the toolbar or press the
BACKSPACE key.
To see a list of the last few pages you visited, click the small down arrow beside the Back or Forward
button. Then click the page you want.
If you want to view one of the last five pages you visited in this session, click the File menu and click
the page that you want to go to. This list is started fresh every time you start Internet Explorer.
To view more pages, including pages you visited in previous sessions, click the History button on the
toolbar and then click the appropriate folder.

Change the appearance of the toolbar
•
•
•
•
•
•

You can move or resize the Address bar and Links bar by dragging them up, down, left, or right. You
can even move them into the menu bar.
To make more room on your screen, you can hide toolbar button labels. Just right-click the toolbar and
clear the check mark next to Text Labels.
You can hide the Address bar or Links section of the toolbar by right-clicking the toolbar and clearing
the check mark for each item you want to hide.
You can add items to the Links bar by dragging the icon from the Address bar or dragging a link from a
page.
You can rearrange items on the Links bar by dragging them to a new location on the bar.
You can use smaller Microsoft Office–style toolbar buttons. On the Tools menu in a browser window,
click Internet Options, and then click the Advanced tab. In the Toolbar area, select the Small Icons
check box.

Use pop-up menus for quick access
Internet Explorer 5.0 features pop-up shortcuts to functions like Save As, Open, and Copy. To access a
pop-up menu:
1.
2.

Place the mouse cursor on a hypertext link or graphic image, and right-click.
Internet Explorer will display one of three pop-up menus you can use to quickly perform the desired
function.

Pop-up menu functions include:
• Add to favourites
• Back
• Copy background
• Copy shortcut
• Forward
• Open link
• Open link in new window
• Print target
• Refresh
• Save background
• Save picture as
• Save target as
• Select all
• Set as wallpaper
• Show picture
• View source
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THE CACHE AND TOOLBAR
You've arrived at this page, so you already know something about how to use a Web browser. Just in case
you haven't yet used some of the features of Microsoft Internet Explorer, here's a guide to them.
Cache
When you explore the World Wide Web, your browser keeps track of the pages you've visited and saves
them on your hard disk so they'll load faster when you return to them. This saves you time and money
because you can view the saved pages without being connected to the Internet. The saved files, your
“temporary Internet files,” are stored in your disk cache.
To empty your disk cache.
When you browse, your disk cache can fill up with files you no longer need. Here's how to empty your
Internet Explorer disk cache.
For Internet Explorer 5.0:
1.
2.
3.
4.

On the Tools menu of your Internet Explorer toolbar, click Internet Options.
Click the General tab.
In the Temporary Internet Files area, click Delete Files, and then click OK.
Click OK to close Internet Options.

For Internet Explorer 4.01:
1.
2.
3.
4.

On the View menu of your Internet Explorer toolbar, click Internet Options.
Click the General tab.
In the Temporary Internet Files area, click Delete Files, and then click OK.
Click OK to close Internet Options.

To change the size of your Internet Explorer disk cache.
You can change the amount of hard-disk space reserved for your disk cache. A larger disk cache may
display previously visited pages faster, but it will decrease the amount of hard-disk space available for
other files. Here's how to set the size of your disk cache.
For Internet Explorer 5.0:
1.
2.
3.
4.
5.

On the Tools menu of your Internet Explorer toolbar, click Internet Options.
Click the General tab.
In the Temporary Internet Files section, click Settings.
In the Temporary Internet Files Folder section, drag the arrow on the Amount of Disk Space to Use
slider to the percentage of disk space you want designated for your disk cache, and click OK.
Click OK to close Internet Options.

For Internet Explorer 4.01:
1.
2.
3.
4.
5.

On the View menu of your Internet Explorer toolbar, click Internet Options.
Click the General tab.
In the Temporary Internet Files section, click Settings.
In the Temporary Internet Files Folder section, drag the arrow on the Amount of Disk Space to Use
slider to the percentage of disk space you want designated for your disk cache, and click OK.
Click OK to close Internet Options.
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Toolbar
The Microsoft Internet Explorer toolbar consists of buttons that are shortcuts for menu commands. They
make browsing faster and easier. Click any button on the toolbar below to find out its function.

•

Back – Lets you return to pages you've viewed, beginning with the most recent. With Microsoft
Internet Explorer 5.0, right-click the Back button and select from a list of recently visited sites.

•

Forward – Lets you move forward through pages you've viewed using the Back button. With Internet
Explorer 5.0, right-click the Forward button and select from a list of recently visited sites.

•

Stop – Halts the process of downloading a Web page. Click this if you want to stop downloading a
page for any reason— for example, if you're having trouble downloading it or if you don't want to wait
for it to download. Then try downloading it again or browse elsewhere.

•

Refresh – Updates any Web page stored in your disk cache with the latest content. When you return
to a page that you've visited, your browser displays the file stored in your disk cache, rather than the
current page on the World Wide Web. This saves download time.

•

Home – Returns you to your home page. You can designate any Web page as your home page.

•

Search – Displays a choice of popular Internet search engines in the left pane. Your search results
appear in the left pane, too. When you click a link, the page appears in the right pane, so you don't
lose sight of your search results.

•

Favourites – Displays a list of the sites—and, with Internet Explorer 5.0, the folders, files, and
servers—that you've saved as Favourites. Click any item in the list to jump to it.

•

Print – Prints the page you're viewing. This is one way to save information from the Internet so that
you don't have to reconnect to view it again. You can even print the URL associated with each
hyperlink, making it easy to navigate to the site later.

•

Font – Lets you display text in a larger or smaller font with Internet Explorer 5.0.

•

Mail – Connects you to the Microsoft Outlook® Express messaging and collaboration client so you can
read e-mail and newsgroup messages.

•

Edit – Opens a file in the Microsoft Word, word processor that contains the HTML code for the page
you're viewing so you can see and even edit it.
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UNLEASH THE POWER OF THE INTERNET
What is HTML?
HTML (or hypertext mark-up language) is a programming language used to build Web sites. It contains
standard codes (or tags) that determine how a Web page looks when your browser displays it. HTML tags
also make possible the hyperlinks that connect information on the World Wide Web.

Why do some Web pages take so long to download?
Many factors affect how fast a Web page travels from its Web site to your computer. Web pages may load
slowly for these reasons:
•
•
•
•

Your modem transmits data slowly.
Traffic on the Internet is heavy.
The page's file is large. It contains graphic, sound, or video files, for example, in addition to text.
The server and connecting lines used by your online service, your Internet service provider, or the
Web site transmit data slowly.

To decrease download time, try these pointers:
•
•
•
•
•

Get the latest version of your browser software.
Buy a faster modem that transmits at a rate of at least 28,800 baud.
Browse during off-peak hours.
Turn off sound and images in your browser software. Text-only pages load faster.
If a page is loading so slowly that you think it may be stuck, click the Stop button on your browser's
toolbar, and try to load the page again in a few minutes.

What is Active Desktop?
The Active Desktop™ interface is a feature of Microsoft Internet Explorer version 5.0 that allows your
desktop to function like a browser. Here are some of the things you can do using Active Desktop:
• Get easy, instant access to your most-used applications, including tools such as corporate directories
and search engines.
• Display multiple HTML pages and pictures from the World Wide Web or your local network or hard
disk.
Create windows on your desktop for the objects you're interested in so the information you need is
delivered directly to you.
• Place ActiveX®-based and Java components alongside existing desktop icons, giving you
customisable space for your favourite Web content and notifications of new e-mail.

What is FTP, and what does it have to do with downloading?
FTP is short for "file transfer protocol." It's a system of rules for communicating over the Internet, and it
allows you to transfer files to and download files from other computers. A Browser software such as
Microsoft Internet Explorer contains the tools you need to handle FTP. So with Internet Explorer, you can
download any file available on the Internet.
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
INTERNET SEARCHES
This task will help you to find relevant information from an internet search, and show you how to save the
text and images.
SEARCHING ON THE INTERNET
1. Open a web browser that allows you
to download and view pages of the
Web:

2. Click on the Search button.

3. There are many different search
engines e.g. Yahoo, Excite,
Infoseek, Google, Alta Vista.
Choose Excite for this exercise.

Netscape Navigator

4. Type the words ‘key skills’ in the
box. Please be sure to spell the
words correctly. Click on the Search
button to the right. (Notice that more
than 100,000 web pages were
found!).

5. The top ten sites are displayed.
Choose one of the sites (highlighted
in blue), a hand will appear when
you move the pointer over it. Click
on it and read the web page.

6. Click the Back speed button to
return to the search list.

Microsoft Internet Explorer

7. Move on to search results 11-20 by clicking on
page 2 of the Results:

8. This time go to a web page by using the right mouse button and clicking on Open in a New Window.

9. Try another search engine.
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ADVANCED SEARCHING
1. If you enter several keywords, type them in descending order of importance. Try Bradman Cricket
Australia.

2. Quotation marks can be used to group words together – useful when looking for a name. Try looking
up “Gordon Brown”.

3. The word AND, or one of the symbols +, & is used to combine words for searching – all terms must be
found in a document for a result. Try the following internet query: Royal AND Family.

4. NOT or the minus sign (-) are used to eliminate a word from a search. Try: Royal + Family - Diana.

5. OR is used to give a choice of terms in searching. This is best used when either one of two similar
terms could be found in a document. Try: Rainforest AND (deforestation or logging).

6. Another useful way of being specific is to look only at titles. In Yahoo place ‘t:’ in front of the keywords
you are searching for.

7. Most search engines will have a Search Help or Advanced Search Button, click on it to get specific
advice.

BOOKMARKS
Keep a note of the web pages to which you may wish to return by using the bookmark feature.
1. Go to the BBC web page:
Htpp;//www.bbc.uk/home/today

2. Click on Bookmark; Add Bookmark,
(in Internet Explorer - Favorites).

3. Exit from your web browser and
then reopen it. Click on the
Bookmark (Favorites) speed button and click on the appropriate name to return to the BBC Homepage.

SAVING PICTURE FRAMES
Choose an image from the web page and save it to disk. Right click the picture, choose Save Picture As,
give it a name, and specify the location to save it in.

COPYING PICTURE FRAMES
Choose an image from the web page and place it onto the clipboard, by using Edit; Copy (or Ctrl+C).
Open a wordprocessing application and use Edit; Paste (or Ctrl+V) to paste the picture.
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COPYING TEXT FROM A WEB PAGE
Open a news story by clicking on a link from the BBC homepage. Highlight three paragraphs of text and
use Copy & Paste as above.

SAVING A WEB PAGE
Go to File; Save As (Ctrl+S) and
choose Plain Text if available.

COPYRIGHT
Copyright applies to electronic information as well as paper-based materials so make sure that you are not
infringing any copyright. Do not republish or sell images / text found on the web. Look up The World
Wide Web Consortium's web page on intellectual property rights at: http:/www.w3.org/IPR/

REFERENCES
If you have any quotations or references to online material in your work these should be cited correctly and
with as much information as necessary to allow the user to access the web page.
For example, the above URL cited within a document would be:
<URL:http:/www.w3.org/IPR/
although it is becoming more common to shorten

 Grimsby College
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 1
BUILD-UP EXERCISE: USING A SCANNER
These tasks will help you to scan pictures and text from the documents, books, magazines or newspapers
you have selected. Once on your computer the pictures or text can be imported into a variety of
applications or saved as files for future use. Scanned images and text can enhance multimedia
presentations, reports, newsletters, brochures and other types of communications.
N.b. All scanners come with the software you need to get images and text onto your computer and all work
slightly differently, but the principles are the same. For extra assistance consult the Help drop-down menu
or the manual.

SCANNING AND SAVING A PICTURE
1. Select a picture to scan. Bear in mind that image quality affects scanning results. Pictures with
blurred or missing detail do not scan well. Scanning images printed on glossy paper produces
brighter, more contrasted results.

2. Check your scanner is switched on. (It will need to be switched on before the computer).

3.a For a flatbed scanner - lift the lid, place the picture face down on the scanner glass,
and close the lid.
3.b. For a sheet-feed scanner - insert the picture face up (or place the scanner on the page if
the scanner head lifts from the base).

4.

Open the Scanner Software. You will see a Control
Centre (this may have different names according to
the software being used).

5.

Click on the button for scanning pictures.
(More expensive software may give you the option of clicking a
Preview button first. This then gives you the option of altering
the area to be saved before the final scan).

6.

Choose the option from Colour, Greyscale and Line Art.
(When scanning outlines, or any other black and white images, it is advisable to use Greyscale rather
than Line Art). Click on Scan.
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7.

If available, use the Image Editing Window to
adjust your scan. Try to straighten, rotate, enhance,
or crop your scanned image at this stage.

8.

Choose the Save or Save As command from the
File menu. In the Save As box select a drive,
directory, and format for the file. It may be advisable
to save as a .tif file for best quality. Enter a suitable
file name and click O.K. to save the image.

9.

The picture is now saved as a file and can be
opened into the program that you wish to use it in.

10. Saving large colour images uses a lot of disk space. If you were to
1
scan an 8 /2 by 11 inch colour picture at only 200 dpi (dots per inch),
the file size would be 10.7 MB (megabytes). An empty high-density
floppy disk will hold 1.44 MB!
If drive space is a problem try one or more of the following:
a) Scan in colour at a lower resolution (in the example above at 100
dpi the file size would be 2.75 MB).

b) Scan the image in Greyscale (in the example above it would cut the file size to 3.5 MB, or 913 KB at
100 dpi).

c) Save in JPEG format (.jpg) to compress the file.

d) Resize or crop the picture in an image editor such as PhotoShop.

SCANNING A PICTURE DIRECTLY INTO AN APPLICATION
It is possible to scan a picture directly into an application (most applications are TWAIN compliant which
makes this possible).
1. Always open the other application first. Try Microsoft Publisher, and select Blank Page, Full Page.

2. Go to Insert; Scanner Image. Select Scanner. Check the scanner is installed.

3. Go to Insert; Scanner Image. Acquire Scanned Image. The Control Centre will appear. Follow
the steps taken in the section above.

4. It is not unusual to scan an image a couple of times before getting it right. Discard the image and try
again changing one or two settings until you are happy with the result.
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SCANNING TEXT
Printed material can be scanned and converted into editable text by Optical Character Recognition (OCR)
software such as versions of OmniPage and Textbridge. However, do not put too much faith into these
packages - after a couple of trial runs you should be able to decide whether it would be quicker to type in
text from future documents.
1. For your first attempt select a document with clear printing, such as from a laser printer. Avoid
coloured backgrounds, smudgy print, small dense fonts, tables and multiple columns. Even the most
expensive software is not 100% accurate.

2. Open the application (e.g. Textbridge, Omnipage) and load the paper in the scanner as before.

3. Click on the button for Scan Text.
(Some programs may give you the
option to create text boxes or zones
at this stage for greater accuracy).

4. You will hear the scanner as it
scans in your text and see the page
slowly becoming grey or blue as the
program decides what the letters
are.

5. You are presented with two or three
choices - send to the clipboard,
save to a file, or export to a wordprocessing package (e.g. Word,
WordPerfect).
Either
Or

Send to the clipboard,
Open a word-processing program and then Edit; Paste into a document
Export into the word-processing program.

6. It is important to edit the scanned text in a word-processing package as all OCR software makes some
mistakes. Typical errors are a d getting read as a cl, a 1 or ! as l, an m as in, or an e as c. If the
computer could not decide what the letter was a ~ will appear. Proof read, spellcheck and reformat the
document until you are satisfied with it.

7. Make sure you save the final
version of your document. Rich
Text Format (.rtf) is a good choice
for saving your scanned text as it
will maintain bold, italics and some
fonts, but can be read by all modern
wordprocessors.
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INTRODUCTION

This work book will introduce you to ideas about how drawing is used. You will be using the drawing
toolbar with in Microsoft Word, a word-processing package that you have already used.
Drawing packages are used in a wide range of situations and in many different types of organisations, e.g.
in engineering and construction, maps, illustrations, scientific experiments, family trees designing posters
and cards.
This work booklet will help prepare you for the Key Skills Information Technology test. It will show you how
to produce two-dimensional drawings. Some more complex packages can produce three-dimensional
drawings.
Before starting the exercises in this booklet, ask your tutor to reset the drawing package. This will ensure
that the lines & objects that you draw will appear as ‘normal’ lines.

If in doubt - Ask your assessor.
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DISPLAYING THE DRAWING TOOLBAR
Before you can use any of the drawing buttons on the drawing toolbar, you must make sure that the toolbar
is visible. Remember a toolbar is simply a row of buttons that are grouped together. For instance the
standard and formatting toolbars on the word-processing screen

Note : As shown in the diagram above, toolbars can be placed anywhere on the screen. If you are unsure
how to do this ask your tutor to show you.

To display the Drawing Toolbar

Click the drawing button.
This is located towards the right hand side of the standard toolbar.

USING THE TOOLBAR TO DRAW SHAPES

For most drawings that can be drawn using this package can be made up by using the following primitive
shapes. This is true no matter how complex the drawing looks.

Line
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Freeform

To draw a shape
1.

Click the mouse pointer over the rectangle button.
Rectangle button

2.

Move the pointer over a clear part of the screen

3.

Hold down the mouse button, with the button still held, move roughly 1 inch down and 1 inch across.

4.

Release the mouse button.

5.

Click the mouse pointer over the AutoShapes button.
AutoShapes button

6.

Click the mouse pointer over the Type of AutoShape (try Basic Shapes).

7.

Click the mouse pointer over the Shape you require (try the Arc Shape
button).

Arc Button

8.

Move the pointer over a clear part of the screen.

9.

Hold down the mouse button, with the button still held, move roughly 1 inch down and 1 inch across.

10. Release the mouse button.
NB: This is the general procedure that you would use to draw a Line, rectangle, Ellipse or an Arc.
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Handles
When the shape is first drawn, you will notice a number of small rectangles attached to the shapes corners
and sides. These are known as Handles.
Different handles have different functions and are described below.
Corner handles
adjust the size &
shape of the
rectangle.

Handles at the side
of a rectangle adjust
the width or height.

Handles at the start or end of
a line allow you to relocate
the start or end of a line.

Corner handles adjust the
size & shape of the ellipse.

Handles at the side of an
ellipse adjust the width or
height.

Handles at the start or end
of an arc allow you to
relocate the start of end of
the arc.

Handles at the corner
allow you to adjust the
size of the freeform
shape.

 Grimsby College

Handles at the side
of a freeform shape
adjust the width or
height.

20

Practice Exercise
This practice exercise gives you chance to practice drawing the shapes that you have been reading about.
If you draw a shape that is in the wrong place, try using the handles to adjust the shape so that it is correct.

EXERCISE 1 - STEP 1
1.

Copy the drawing of a house shown below.

EXERCISE 1 - STEP 2
1.

Place your name at the top of your drawing.

2.

Print out one copy.

3.

Save your work to your floppy drive under the name "draw 1".

4.

File your work in your portfolio.

ZOOM
The zoom feature of this drawing package works in exactly the same way that the zoom with in the normal
word-processor works. The current zoom level is shown toward the right hand side of the standard tool
bar.
Zoom Level

Using the zoom feature will allow
you to look more closely or more
distantly at your drawing.
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To adjust the Zoom Level
1.

Click the downward arrow that is next to the box that shows the zoom level.

2.

From this list of sizes, click on a different percentage value.

3.

Use the zoom feature to zoom into the drawing of a house. Zoom to a size of 200 % and use the scroll
bars to look at the bottom window.

You will see an enlarged view and you will notice that the lines that previously looked straight are in fact
not very well drawn.
One way to draw shapes more accurately is to zoom in as far as possible (200%) when constructing the
shapes. However, a better way is to use a Grid.

USING A GRID
Using a grid allows you to draw shapes to a multiple of the grid size. For instance if the grid size is set to 1
cm, then it would be simple to draw the following shapes.

Grid spacing at 1 cm

All shapes drawn to
multiples of 1 cm.

Note : In MsWord the grid is not actually visible on the screen.
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To switch the Grid on or adjust the Grid spacing
1.

Click on the “Draw” button
Draw Button

2.

Click on the “snap to grid” menu

button. This is toward the left hand side on the menu bar.

3.

To activate the grid, make sure that the “snap to grid” check box has a tick in it. If it does not, then click
the box until a tick appears as shown below.
‘Snap to grid’ tick

4.

To set the grid size click the up or down arrows that appear next to the Horizontal & Vertical spacing
boxes.
Normally the horizontal and vertical sizes are kept to the same size.

Practice Exercise
For practice, adjust the grid spacing to the following sizes and copy the shapes below. You should be able
to make exact copies.
If you feel that you do not need much practice, then just draw the glasses.

2 cm

5 cm

Grid size at 1 cm

Grid size at 1 cm
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EXERCISE 2 - STEP 1
1.

Copy the drawing shown below.
The grid has been drawn for you at size 1.2 cm, some lines require the size to be altered to 0.6cm.

EXERCISE 2 - STEP 2
1.

Type in your name on the top of your page.

2.

Print out one copy.

3.

Save your work under the name "draw 2".

4.

Make any necessary changes to make your diagram the same as the one below.
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EXERCISE 2 - STEP 3
1.

Print out one copy.

2.

Save your work under the name "draw 2a".

3.

File the work in your portfolio.

GROUPING & COPYING
Objects are normally grouped together so that they can all be moved or copied together at the same time.
For instance supposing you were trying to draw a calculator. The quickest way to draw the keypad would
be to draw a single key and then copy this for all the other keys.
Although the key is just a single key, it may be made up of several lines or different shapes. For this
reason, before the key can be copied, the different lines must be grouped together. Once different lines
are grouped together, they act as though they are all a single object and can be moved, copied or re-sized
together.

Practice/training exercise
Follow this worked example to see how to group & copy individual lines.
1.

Set the grid size to 0.4 cm and draw a single key. The individual lines & arcs that make up the key are
shown below on the left, the key & grid size are shown on the right.

2.

To group the individual lines together, hold down the shift key, keep this held until you are told to let
go.

3.

One-By-One, click on each line or arc. When you are doing this, it tells the computer which lines or
arcs you wish to group together.

4.

When all 8 lines are selected, release the shift key.

5.

Click on the “Draw” button.
Draw Button
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6.

Click on the 'group' menu button.

This is toward the top of the menu bar.

7.

The individual lines are now grouped together, to test this, try moving or re-sizing the object.
Note: At any time it is possible to ungroup an object. See the help sheets later on for help concerning
this.

8.

To copy this key, click on the key.

9.

Go into the Edit menu & select Copy.

10. Go into the Edit menu & select Paste.
A copy of the first key will appear on the screen. Perform the above copy until you have a total of 12
keys.
11. Arrange the keys in a pattern, as shown below.

SUMMARY
So far you have looked at the basic features of the drawing package, these include.
•

Displaying the drawing toolbar

•

Drawing primitive shapes - Lines, Rectangles, Ellipses, Arcs and Freeform.

•

Using Handles

•

Zoom Levels

•

Use of the Grid

•

Copying

•

Grouping

If you are unsure or would like to discuss any of the above, ask your assessor now, before continuing
through this booklet.
The second part of this booklet consists of drawing exercises, along with help sheets. You will need to
refer to these help sheets because you will be asked to use features that have not been covered before.
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Winning Flag Exercise
Set the grid size to 0.25cm, make sure that the grid is switched on.
Create the following shape using the FreeForm tool.
Grid

Change the Fill of the shape so that it is solid black. When you have done this it should look like this (see
help on Fill):

Copy this shape 11 times and arrange them as shown below:

Using the Line tool, create a box around the flag as shown below:

Create a handle for the flag, as shown below:

 Grimsby College

27

Adjust the thickness of this line so that it is 4 times as thick as a normal line. It should now appear like this
(see help on line Style):

Group all the objects together. If you want to check that you have grouped all the objects, try moving them
together. If you have made an error, use Undo and try again.
Copy the flag, and flip the flag horizontally. Position it as shown below. The completed flag should look
like this (see help on Horizontal & Vertical Flip):
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Motor Speed (bar chart) Exercise

EXERCISE 3 - STEP 1
1.

Set the grid size to 1 cm, make sure that snap to grid is switched ON.

2.

Copy the thick lines below. The thinner ones are just to show the grid size.

EXERCISE 3 - STEP 2
1.

Insert a text box in the position shown below. Label the graph as shown below.
You will need to adjust the size of the text inside the text box to size 8 (see help on Text Box).
You should not actually be able to see the border of the text box, I have shown this with a dotted line.

3000

2500

2000

1500

1000
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0
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EXERCISE 3 - STEP 3
1.

Adjust the grid size to 0.5 cm and construct the graph values using filled rectangles. Make sure that
each rectangle is filled with a different colour.
3000

2500

2000

1500

1000

500

0

EXERCISE 3 - STEP 4
1.

Type your name on the top of the page.

2.

Print out one copy.

3.

Save your work to your floppy under the name "draw 3".

EXERCISE 3 - STEP 5
1.

Insert another text box in the position shown below.

2.

Type the legend text in, this text will need to be size 12.

3.

Create filled rectangles that correspond with the graph values. To draw these boxes the grid must be
set to 0.1 cm.
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EXERCISE 3 - STEP 6
1.

Add the title & label the vertical axis to complete the graph.

2.

Save the file to your floppy drive under the name "draw 3a".

3.

Print out your work.

4.

File your work in your portfolio.

Speed
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A/C Motor Speed
Population Pie Chart Exercise
1.

Set the grid size to 1 cm, make sure that snap to grid is switched ON.

2.

Draw a 2cm Arc using the AutoShapes menu on the draw toolbar.

3.

Colour the Arc in using downward arrow next to the 'Fill colour' tool on the draw toolbar

Downward arrow next to
the 'Fill colour’ button
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This will reveal the 'Fill colour' box

4.

You may now select an appropriate fill colour for the Arc by clicking on a colour using
the left hand button of your mouse - this will be the first segment of your pie chart.

5.

Select the segment by clicking it one then copy it using the 'copy' tool

6.

Now past the object using the 'paste' tool

on the Standard toolbar.

on the Standard toolbar.

The objects will look something like this

7.

Select one of the Arc's by single clicking over it with the left hand button of your mouse.
The handles should now appear

8.

handles

Select the Draw menu on the on the draw toolbar
Draw menu button

9.

Select Rotate or Flip then Flip Horizontal
The objects will look something like this
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10. Select one of the Arc's by single clicking over it with the left hand button of your mouse.
11. Rearrange the Arc's to for a semicircle -by dragging the object
12. Position the cursor over the object until the cross appears similar to the one below. Press on the left
hand mouse button without letting go drag the object to its new position then let go.

13. Select the Segments thus

14. Recolor it using the 'Fill colour' tool on the draw toolbar

15. Click on the Select Objects tool

on the draw toolbar

16. Draw a box around both objects that form the semicircle
The object should now appear like this

17. Now group the objects by selecting the Draw menu on the draw toolbar and then
group from the top of the revealed menu.

18. Now Copy, Paste and Rotate Vertical using the same procedure as before then rearrange the new
semicircle and recolor for your pie chart.
You should now have a pie chart similar to the one below.
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HELP SHEET - FILL
This refers to how the inside of a bounded object is filled. You have a choice of many different colours and
different hatch styles. A number of examples are shown below.

To change the Fill style of an existing shape do the following,
1.

Make sure that no objects are selected. If necessary, click in free space to do this.

2.

Move the mouse pointer over the object until the pointer changes to show four arrows,
looking like this.

3.

Double click on the object.
You will be presented with the Drawing Object dialogue box, like this.
Colour and
lines tab

4.

Make sure that the Colour and Line Tab is selected

5.

Select the desired Fill colour.

6.

Or Select Fill Effects and select a pattern then Click OK when done .

7.

Click OK when done.

Note: This new Fill pattern will be used for all future bounded objects, until the fill style is changed.
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HELP SHEET - LINE STYLE
A line can be drawn in any colour and with many different settings of line style. A number of examples are
shown below.

To change the Line Style of an existing line do the following,
1.

Make sure that no objects are selected, if necessary, click in free space to do this.

2.

Move the mouse pointer over the line until the pointer changes to show four arrows,
looking like this.

3.

Double click on the Line.
You will be presented with the Format AutoShape dialogue box, like this.

Colours and
lines tab

Line thickness

4.

Make sure that the Line tab is selected

5.

Select the desired colour.

6.

Select the desired weighting to change the line thickness

7.

Click OK when done.

Note: This new line style will be used for all future lines, until the line style is changed.
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HELP SHEET - FLIP HORIZONTAL & VERTICAL
The Flip horizontal & Flip vertical buttons allow you to flip an object about a horizontal or vertical axis.
For instance imagine the picture of a computer disk, this can be flipped, as shown below:
To flip an object

Disk as it was drawn
1.

Horizontal Flip

Vertical Flip

Horizontal &
vertical Flip

Select the object to be flipped
Draw Button

2.

Click on Rotate or Flip on the Draw Menu

3.

Click either the flip horizontal

or the flip vertical

button on the menu bar.

HELP SHEET - TEXT BOXES

Using the word-processor it is possible to place text anywhere on the screen. However using a text box
offers two advantages,
•

It is easier to move a block of text

•

You don’t need to use tabs or spaces to put the text in the correct position.

To insert a text box, use exactly the same procedure as you would to draw a rectangle. The only difference
is that you would use the text box button
instead of the rectangle button.

Once you have a text box on the screen, it can be moved or re-sized just as any other shape.
You will not be allowed to write more text than will fit into the text box.
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
GRAPHICAL REPRESENTATION OF DATA SOFTWARE

INTRODUCTION
Graphical Representation of Data software allows you to output numerical information as a graph, chart or
diagram. The graphing function of a spreadsheet package such as Microsoft Excel, Claris Works or Lotus
1-2-3 can be used, or software especially designed for graphic displays, such as Delta Graph or
CricketGraph. Converting numerical data into pictorial form makes it easier to read, understand and
analyse.

MAIN FEATURES
The software can:
•

Quickly produce professional looking charts.

•

Allow you to select the graph or chart that is best suited for your readers or audience.

•

Write headings or labels in a variety of fonts and sizes.

•

Easily adjust the size and scale of your display, add legends, and alter the colours on the chart.

•

Save graphs to disk and print graphs.

•

Edit data without having to create a new graph

•

Link charts to the worksheet data they are created from so they are updated when you change the
worksheet data.

•

Paste or insert charts into word processing, presentation and desktop publishing packages.
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THE PARTS OF A CHART

THE TITLE

Legend

Y axis

Data labels

X axis
The Title summarises what the graph or chart is showing. It should be descriptive and clear. It is usually placed
above or below your graph.
The Axes are the lines of reference against which the information is plotted. The axes have to be clearly
named but try to avoid cluttering the graph with too much text. Where appropriate the units of
measurement should be included e.g. '£', 'cm', 'per week'.
The x-axis is the horizontal axis. This is normally used to show categories of the data.
The y-axis is the vertical axis. This is normally used to show the range of values for the
categories in the graph.
The Scale is how the units of measurement are represented on the axis. The choice of scale can greatly
affect the visual impact of the graph.
The Data labels explain the segments of a pie chart or the bars of a graph.
The Legend explains the patterns or colours used. A legend is helpful with pie charts and comparative
graphs but may be unnecessary with other charts.
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TYPES OF CHARTS
There are three broad categories of charts:

GRAN CANARIA - AVERAGE
HOURS OF SUNSHINE 1999
A Bar chart uses columns for each item
of data. The bars should go vertically.
(Note Excel rather confusingly calls these
'column' charts).

8

AVERAGE
HOURS OF
SUNSHINE

6
4
2
APR

MAR

FEB

JAN

NOV

DEC

0
OCT

Bar charts best represent data over time
and allow one-to-one comparisons of the
data series. In the example, the shortest
bar is December, which shows that it was
the winter month in Gran Canaria with
the least sunshine.
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Line graphs are used to show trends in
data. The data series is plotted at equal
time intervals. The example shows how
U.K. North Sea oil production was on an
upward trend until 1984 when a decline
began.

140

OIL PRODUCTION
(Million tonnes)

A Graph plots a series of points, with
each point being determined by a pair of
co-ordinates. Usually, the points are
joined together by a line.

YEAR

GOVERNMENT INCOME (2000)
A Pie chart consists of a circle divided
into a number of segments. The values
in the data series are totalled, so that
each value can be calculated as a
percentage of the total.
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The pie chart to the right shows at a
glance that income tax is the largest
single source of Government Income in
the year 2000.
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CREATING A GRAPH IN EXCEL
Excel 97 provides a quick way to produce a professional-looking chart:
Load Excel and enter the data and headings in the cells.
Highlight the data you want to graph. Select both the numeric data and the adjacent row and column
labels. (The labels are used for axis and legend information).
Use the Chart Wizard (or press F11 for a quick bar chart).
Using the Chart Wizard
It is advisable to use the Chart Wizard. The Chart Wizard provides a wide range of options so you can
create a chart that meets your needs. There are 4 easy steps and at each step there is a dialogue box. At
any stage you can press Cancel to return to the worksheet or Finish to complete the creation of a chart.
To select the Chart Wizard click the graph icon
and click on Chart).

on the toolbar (or go to the Insert menu

Step 1
1.

Choose the type of graph you want.

2.

(Think twice before using 3-D
effects as they can obscure what
you are trying to show).

3.

Press and hold the Preview option
to see how it will display.

4.

Click Next to move to Step 2.
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Step 2
Usually you will not need to make
changes at Step 2. However, if the
chart looked wrong at the preview stage
(as in the case of this line graph):
1.

The Data Range tab allows you to
change the data range you selected
or to use rows instead of columns
as the basis for the data series.

2.

The Series tab allows you to
change the ranges that identify the
series names, values and X-axis
labels.

3.

Click Next.

Step 3
1.

Click on each tab at the top of the
dialogue box.

2.

Make your choices relating to
Titles, Axes, Gridlines, Legend,
Data Labels and Data Table.

3.

Click Next.

Step 4
1.

Select the Location for your chart.
Create a separate worksheet (which
you can name) or embed the chart
in the same worksheet as the data.

2.

Click Finish.
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
CREATING GRAPHS AND CHARTS
This exercise covers Excel 97 chart features. It will show you how to:
•
•
•
•
•

Enter and select data.
Create a pie chart.
Create a bar chart and a comparative bar chart.
Create a line graph.
Save and print your chart.

TO ENTER DATA
1.

Start Excel. Excel labels each column with a letter and each row with a number. Each box in the grid
is called a cell and each cell is identified by a cell address - A1 for example.

2.

Type 'ITEM' in cell A1 (the active cell). Press Enter.

3.

Write 'Food And Drink' in cell A2, press Enter.

4.

Continue to enter all the data in the table below. To change the active cell from A8 (Mortgage) to B1
(EXPENDITURE per month) use the mouse to click on cell B1:

ITEM
Food & Drink
Electricity
Gas
Council Tax
Water Rates
Telephone
Mortgage

EXPENDITURE (per month)
£200
£30
£25
£60
£30
£25
£100

TO SELECT THE DATA AND HEADINGS
Click on cell A1, press and hold down
the left mouse button, drag diagonally
down to cell B8, and release the mouse
button. (The active cell, A1, is still part
of the selection, even though it is white).
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TO CREATE A PIE CHART METHOD 1
Create a pie chart showing household
expenditure per month.
1.

Click on the ChartWizard icon on
the Toolbar.

2.

In Step 1 of the Chart Wizard click
on Pie from the Standard Types
list.

3.

Select the top left Chart sub-type.

4.

Hold down the Press and hold to
view sample button.

The pie chart should be displayed. Notice that percentages (or
values) for each item are not yet displayed.
5.

Click on Next > to move to Step 2.

6.

As the data selected looks O.K.
click on Next > to move to Step 3.
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7.

Click on the Titles tab. Type: 'HOUSEHOLD EXPENDITURE’ (per
month)'

8.

The Legend is O.K. so click on the Data Labels tab next. Click on
Show Percentage.

9.

Click on Next > to move to Step 4.

10. At Step 4 you have a choice
between overlaying the new chart
on the worksheet or placing it in a
new sheet. Choose As new sheet.
11. Click on Finish. The new chart will
appear.

12. Go to the File menu and click on
Save As.
13. Type 'Expenditure.xls' as the File
name. Click on Save.

TO CREATE A PIE CHART METHOD 2
Create a pie chart showing Government Spending 2000-1.
1.

Start Excel and enter the data below:

AREA
Social Security
N.H.S.
Education
Debt Interest
Defence
Law and Order
Industry, Agriculture and Employment
Housing and Environment
Transport
Other

EXPENDITURE (in billions)
£103
£54
£46
£28
£23
£20
£15
£14
£9
£59

2.

Select the data and headings.

3.

Click on the Chart Wizard icon and work through the 4 steps as before except:

4.

At Step 3:
Click the Titles tab. Type 'Government Expenditure 2000-1 (in billions)'.
Click the Data labels and select Show value.
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5.

When you click Finish, go to File and click Save As. Type 'Government Expenditure.xls' as the
filename.

TO CREATE A BAR CHART
Create a bar chart showing the average water temperatures at Bridgeport, U.S.A.
1.

Go to File and click on New. Double click on the workbook icon.

2.

Enter the following data and headings:

MONTH
May
June
July
August
September

BRIDGEPORT
58
67
72
76
72

3.

Select all the data and headings.

4.

Click on the Chart wizard icon.

5.

At Step 1 select Column (It is best to have vertical
bars).

6.

Choose the top-left Chart sub-type (this will
probably be selected already).

7.

Click and hold down the Preview button. Click
Next >.

8.

Step 2 click Next >.
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9.

At Step 3 click the Titles tab. As
the Chart title type 'Average water
temperature at Bridgeport'.

10. As the Category (X) axis type
'Month'.
11. As the Value (Y) axis type
'Temperature (degrees Fahrenheit)'.
12. Click on the Gridlines tab. Check
that Major gridlines are ticked on
the Value (Y) axis.
13. Click on the Legend tab. Click on
the Show legend box to remove the
tick (and to remove the legend from
the chart).
14. Click Next >.
15. At Step 4 select As new sheet. Click Finish.
16. Save As 'Water temperature.xls'.

CREATING A COMPARATIVE BAR CHART

Create a bar chart comparing the average water
temperatures in Bermuda and Bridgeport.
1.

Go back to the worksheet by clicking on Sheet 1 at
the bottom of the screen.

2.

Add this column, starting in cell C1:
Bermuda
80
81
82
83
83

3.

Select all the data and headings and click on the
ChartWizard icon.
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4.

Go through 5-14 of ‘To Create a Bar
Chart’ with these changes:
At Step 3 the Chart Title should
read 'Average water temperatures in
Bridgeport and Bermuda'.
The Legend should be displayed.

5.

Go to the File menu and click on
Page Setup.

6.

Click on the Header tab and on
Custom Header.

7.

Type your name and the date.

8.

Click O.K. to leave the Header
dialogue box and again to leave
Page Setup.

9.

Save As 'Comparative graph.xls' and Print a copy.
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CREATING A LINE GRAPH METHOD 1

Produce a line graph for the number of cars sold in the period August 1999 to March 2000.

MONTH
Aug-99
Sep-99
Oct-99
Nov-99
Dec-99
Jan-00
Feb-00
Mar-00

1.

Open a new worksheet and enter the data above.

2.

Select the data and use the
ChartWizard to create the line
graph.

3.

At Step 1 try the different sub-types
of Line graph and check with the
Preview button until you are
satisfied with your choice.

4.

At Step 3 include:

CAR SALES (Thousands)
120
81
63
50
43
35
43
49

Chart Title - NUMBER OF CAR
SALES,
X Axis Title – MONTH,
Y Axis Title – CARS SOLD (in
thousands)
At Step 3 do not display the
Legend.
5.

At Step 4 select As new sheet.

6.

Add your name and the date. (Go to File; Page Setup; Header; Custom Header).

7.

From the File menu, Save As 'Car Sales.xls', check it with Print Preview, and Print a copy.
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TO CREATE A LINE GRAPH METHOD 2

Produce a line graph for the number of cars sold by a garage between 1990 and 1995.
(This line graph shows you how to use Step 2 of the ChartWizard when the graph looks wrong at the
preview stage).

1.

Enter the following data onto a new worksheet:

YEAR
1990
1991
1992
1993
1994

NUMBER
50
75
37
38
49

2.

Select the data and click on the ChartWizard.

3.

At Step 1 select Line Graph.

4.

Look at the Preview. (Notice the graph has 2 lines plotted instead of one, and the X and Y axis scales
look wrong). Click Next>.

5.

At Step 2 click on the Series tab.
Click on YEAR and press Remove.
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6.

For Category (X) axis labels, click on the collapse dialogue button just above the
word ‘Finish’.

7.

Highlight the range of years on the
worksheet and click on the collapse
dialogue button again.

8.

Click Next>.

9.

At Step 3 enter the Chart Title 'LINE
GRAPH' and the Axis headings
'YEAR' & 'NO.'

10. Make sure the Legend is not displayed. Click Next>.
11. At Step 4 select As new sheet (Chart 1). Click Finish.
12. Save As 'Line graph.xls'.

LINE GRAPH
80
70
60
No.

50
40
30
20
10
0
1990

1991

1992

1993

YEAR
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1994

1995

KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
MODIFYING GRAPHS AND CHARTS
This exercise show you how to:
•
•
•

Change the type of chart
Format and modify your chart
Move a chart or graph to another worksheet or application

TO CHANGE THE LOCATION OF A CHART
1.

Enter the following data about water temperature at Boston harbour into a worksheet:
MONTH
Jan-00
Feb-00
Mar-00
Apr-00
May-00
June-00

2.

TEMPERATURE
40
36
42
47
56
62

Select the data and press the F11 key. A bar chart
should appear on a new sheet.

TEMPERATURE
70
60

3.

To change the location of the bar chart, right mouse
click on the white area around the chart. The menu will
give you several options.

50
40
TEMPERATURE

30
20
10
0
Jan00

4.

Check out some of the options. Click on Chart type
and then Cancel. Repeat for Source Data and Chart
Options. (Note the dialogue boxes from the Chart
Wizard are available).

5.

Select Location. Click on As object in sheet 1.
(This right mouse button method can be used for
any of the commands in the Chart Wizard).
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Feb00

Mar00

Apr00

May00

Jun00

TO EDIT A CHART
The chart is now laid over the top of the
original worksheet.
6.

To edit the chart make sure you can see
the handles around the chart. (If not click
on the chart).

7.

Right mouse click on the white area and
select Chart Type. Click on Line graph
and O.K.

8.

Right mouse click and select Chart
Options:

TEMPERATURE
(degrees F.)

WATER TEMPERATURE IN
BOSTON HARBOUR
As the Chart Title type 'WATER TEMPERATURE IN
BOSTON HARBOUR'
As the X axis label type 'MONTH'
As the Y axis label type 'TEMPERATURE (degrees
F.)'.
Remove the tick in the Show legend box.

80
60
40
20
0
Jan00

Feb00

Mar00

Apr00

May00

Jun00

MONTH

9.

The chart now needs resizing. Drag the sizing handle
on one corner to make it larger. Experiment until you
are happy with the balance of chart and text.

(Double clicking on any item on the chart allows
you to modify it.

TEMPERATURE
(degrees F.)

WATER TEMPERATURE IN
BOSTON HARBOUR
70
60
50
40
30
20
10
0
Jan- Feb- Mar- Apr- May- Jun00
00
00
00
00
00
MONTH
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10. Double click on the vertical (Y) axis.
(The Format Axis Dialogue box
opens).

11. Click on the Scale tab of the
dialogue box. Write 100 as the
Maximum. Click O.K.

12. To remove the grey background
move your mouse pointer over it
until a Plot area label appears.

13. Double click.

14. On the Format Plot Area dialogue
box click on None under Area, and
O.K.
(Keep checking that the chart is
selected with handles around it.
If not, single click inside the chart
box. If you place your mouse
pointer over any area of the
chart, a label pops up. Hence
you can be sure you are on the
correct part before double clicking)
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15. Using the above method, change
the font sizes and styles as follows:
Chart Title
and Bold
Value Axis Title
and Regular
Category Axis Title
and Regular
Value Axis
and Regular
Category Axis
and Regular

- 16
- 14
- 14
- 12
- 12

16. Double click on the horizontal
Category Axis (X).

17. In the Format Axis dialogue box
click on the Alignment tab.

18. Try Automatic Orientation and
experiment with other angles.
Select the one that best displays the
months and years.
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TO COPY AND PASTE A CHART INTO ANOTHER APPLICATION
19. Make sure the chart is selected.
Click in the white chart area (if
handles are not displayed).

20. Click the Copy toolbar button (or
CTRL + C). A dotted line will
appear around the chart.

21. Minimise Excel by clicking on the minimise icon in the top corner of the screen.

22. Open a Word document. Move the
insertion point to where you want to
place the chart.
23. Click the Paste toolbar button (or
CTRL + V). The chart will appear.
24. If the chart is too large, resize it by
dragging the handles inwards.
25. If the text on the chart is too small,
double-click on the chart to select it.
Increase the font sizes as you do in
Excel. Then click outside the chart.

26. Now you no longer need Excel. Use your right mouse
button to click on the Microsoft Excel button on the
Taskbar (at the bottom of the screen).

27. Click Close.

(This method can be used to copy any type of chart, and can be used paste charts into a wide
range of applications e.g. PowerPoint slides, or Publisher documents)
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KEY SKILLS FACTSHEET
INFORMATION TECHNOLOGY
WHAT IS A SPREADSHEET?
A spreadsheet is a software application that allows the user to perform calculations by creating numberstructured information. A spreadsheet is a grid containing numerous rows (9999) and columns (A-AV).
Each row number and column letter is called a cell. A cell can contain text or numbers. When calculating
formulas it is important to use the cell reference (ie B3) rather than the value within the cell. If the value is
used the total will not automatically re-calculate if any values are changed at a later date.

DATA ALIGNMENT
Numerical data within a spreadsheet is automatically right aligned within each cell and text entries are
automatically left aligned. Alignment facilities are available to align column headings appropriately above
numerical data.

SHOW GRID
It is possible to show the whole spreadsheet grid when printing your work. The grid will show the column
letters along the top and row numbers down the side.
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EXAMPLE OF BASIC FORMULAS
A basic formula can consist of adding, multiplying, dividing or subtracting 2 numerical values together. In
the majority of spreadsheet software applications, the formula must begin with the ‘=’ symbol:
1)

=(c4*e4)

or

2)

=sum(c4:d6)

This formula is multiplying the value in cell c4 with the value in cell e4.
This formula is adding a range of values (more than 2 values) together, by locating the first value (cell c4),
the last value (cell d6) and then adding every value between and inclusive of these cells.

EXAMPLES OF ADVANCED FORMULAS
Advanced formulas generally have 2 or more formulas:
1)

=(c4-e4)*17.5%

2)

=(b3+d3)+(c3-e3)*f3

SHOWING FORMULAS
It is possible to show formulas used on screen for the purpose of printing. The totals generated are
switched to formula mode that shows the formula keyed in.

INSERTING/DELETING COLUMNS AND ROWS
Within spreadsheets it is possible in insert or delete columns and rows to enable the spreadsheet to be
updated at a later stage. This facility is ideal when adding and removing unwanted items from a
spreadsheet.

LINKING
A spreadsheet can be linked to other applications or other spreadsheets that are frequently updated. This
linking facility saves time, as all linked documents are updated automatically.

PRODUCING GRAPHS/CHARTS
It is possible to create graphs and charts based on spreadsheet information by using the chart wizard
available in any spreadsheet software application. This facility is ideal if you are wishing to present data in
an illustrated manner.
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KEY SKILLS
INFORMATION TECHNOLOGY
GETTING HELP WITH EXCEL
Microsoft Excel has an on-line Help system, which you can access in several ways. The Help Topics dialog
box enables you to select specific Help information.
To display the Help Topics dialog box:
•

Choose the Help Contents and Index command. The Help Topics dialog box is displayed:

•

The Help Topics dialog box contains three different groups of options. These groups are located on
different tabs:
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Searching for Help Using the Contents Tab
Microsoft Excel Help information is split into several categories and topics in the Help Topics dialog box.
The Contents tab displays these categories and topics and enables you to browse for the Help information
you want.
•

Help categories are represented by book icons. You can open a category to display a list of topics or
subcategories:

•

Help topics are represented by single page icons:

Using Help Categories
•

Make sure the Help Topics dialog box is displayed and the Contents tab is selected.

•

To open a Help category, double-click on the category or select the category and choose the Open
button. A list of further items is displayed beneath that category.

•

To close a Help category, double-click on the category again or select the category and choose the
Close button.

To display a Help topic:
•

Open each of the Help categories leading to the Help topic you want to display.

•

Double-click on the Help topic or select the Help topic and choose the Display button. The Help Topics
dialog box closes and the Help window is displayed. This contains information about the topic on which
you clicked.

Using the Help Window
The Help window contains information on the Help topic that you selected. The Help window is an
application window - it has maximize, minimize and close buttons in the title bar:
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•

The Help window has three command buttons below the title bar:

You can use the Help Topics button to display the Help Topics dialog box.
•

The Back button enables you to return to the previously displayed Help topic. (This button is dimmed if
no Help topic has previously been displayed.)

•

The Options button displays a drop-down menu containing various commands, which enable you to
add, copy and format the Help information. These commands are covered in more detail later in the
Course Notes.

DISPLAYING FURTHER INFORMATION
As well as information on the topic you selected, the Help window also contains areas, which you can click
on to display further information. When you point to one of these areas, the pointer changes to a hand:

Areas Which Display Further Information
•

Many Help windows contain buttons which enable you to start applications or display related topics:

•

In some Help windows, you can click on underlined words to jump to a related help topic.

You can click on words with a dotted underline to display a ScreenTip containing information on that word
or picture - click anywhere to remove the ScreenTip:

Some Help windows contain pictures on which you can click to display a ScreenTip.
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Scrolling Through the Help Window
A scroll bar appears in the Help window when there is more information than can be displayed in the space
available. You can use a scroll bar to browse through this information.
The scroll bar has scroll arrows at the top and bottom and a scroll box between the two arrows:

To use a scroll bar:
•

Click and hold on the scroll box. Drag the scroll box to the new position, then let go.

or:
•

Click in the shaded scroll bar.

or:
•

Click on the scroll arrows at the top and bottom of the scroll bar.
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USING GRAPHICAL HELP WINDOWS
Most Help topics are in text form, with information on how to perform particular actions. Some Help topics
are in graphical form. These topics provide more general information on a particular feature:

To use a graphical Help window:
•

Move the pointer over the box containing the name of the topic for which you want to see more
information. As you move the pointer over the box, the bar on the left of the box changes colour:
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•

Click on the box to display a ScreenTip:

ADDITIONAL HELP
Searching for a Specific Help Topic
The Index tab in the Help Topics dialog box enables you to find Help information on a specific topic by
searching for the title of the topic:
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To use the Index tab:
•

Make sure the Help Topics dialog box is displayed and the Index tab is selected.

•

If you know the name of the topic, type its name in the text box at the top of the dialog box. As you
type, the list box below displays the topic name which best matches what you have typed. (You can
also use the scroll bar on the right of the list box to browse topics - they are listed in alphabetical
order.)

•

Double-click on the appropriate topic in the list box. The Help window appears, with information about
the topic on which you clicked.

CREATING A LIST OF KEYWORDS
The Find tab in the Help Topics dialog box enables you to search within the Help topics for occurrences of
a specific piece of text. The first time you use the Find tab in the Help Topics dialog box, a list of keywords
is created for you to search.
To create a list of keywords:
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•

Make sure the Help Topics dialog box is displayed, then select the Find tab. The first time you select
the Find tab, the Find Setup Wizard dialog box appears containing information on finding keywords:

•

In the Find Setup Wizard dialog box, select the appropriate option, then choose the Next > button.

•

When the new information appears, choose the Finish button. A Creating Microsoft Excel List... button
appears in the taskbar while the word list is created - this may take up to a minute.

Important Point
•

Remember, you only need to create a word list the first time you display the Find tab.

Finding Keywords
When you have created a list of keywords, you can use the Find tab to search all the Help topics for
occurrences of a specific piece of text. For example you could search for copying text to find Help topics
containing information on this subject.
To find keywords:
Make sure the Help Topics dialog box is displayed and the Find tab is selected:

 Grimsby College

65

Type the piece of text you want to search for in the text box at the top of the dialog box - this can be a
single word or a group of words.
•

The list box below displays the matching pieces of text. Click on an item in this box to narrow the
search and reduce the number of topics shown in the list box at the bottom of the dialog box.

•

Double-click on a Help topic from the list box at the bottom of the dialog box to display the topic.

Important Points
•

You can double-click on a Help topic in the list box at the bottom of the dialog box to display help
information for that topic.

•

The two boxes at the bottom of the dialog box display the number of topics which match the search
text and a summary of the Find options:
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Changing the Find Options
The Options button on the Find tab displays the Find Options dialog box. This dialog box enables you to
specify how the Help topics are found, based on the text you type:

To specify whether Help searches for topics containing all the words together or topics containing at least
one of the words, use the options in the Search for topics containing box.
•

To specify how the words you type are matched to Help topics, select an item from the Show words
that drop-down list.

•

The options in the Begin searching box enable you to specify when to begin searching.

•

When you have set the options you want, choose the OK button.

Setting Options for the Help Window
To set options for the Help window:
• Click on the Options button at the top of the Help window.
•

When the Options menu appears, use the commands in the menu to manipulate the Help information:
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EXCEL OVERVIEW
Excel is what is commonly referred to as a spreadsheet application. Spreadsheets can be used to help
you present and calculate rows and columns of data. Common uses for worksheets include: budget
forecasts, employee timesheets, profit & loss accounts, calculation of depreciation, cash flow forecasts and
monthly expense reports. Any report incorporating text, values and calculation formulae, can be created
on a spreadsheet.
Some of the advantages of using a computer based spreadsheet are:
•

You can format the information using a variety of different fonts, lines and shading, making the
information easier to read.

•

Changes can be made to values on a worksheet at any time, and all formulae making reference to
those values will update automatically.

•

Information can be presented graphically using charts of various types.

•

You can incorporate spreadsheet data and charts into slide show presentations.

In this introductory course you will learn how to create spreadsheets incorporating the use of formatting
and calculation formulae.

Loading Excel
To get started you need to load the Excel application. From the Windows95/98 Desktop,
double click on the Microsoft Excel icon on the desktop.

menu on the desktop then click on programs and
An alternative method is to click on the
search the menu system for Microsoft Excel searching the menus by clicking on items with the left hand
button of the mouse.

Note: Microsoft Excel will not be in the same position in the Start menu system on all computers.
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The Excel Screen
When Excel is loaded you will see the application window.
Some of the screen elements can be 'toggled' on or off, therefore your screen may look slightly different
from the illustration below.
Formula Bar

Menu Bar

Formatting Bar

Title Bar

Standard Tool Bar

Status Bar
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Toolbars
A Toolbar has a number of buttons you can use with the mouse to carry out some of the more frequently
used command options. Excel will display appropriate toolbars when you are using certain functions. For
example, when you are creating a chart, Excel will display the Chart toolbar.
When you load Excel, the following toolbars will be displayed on the screen.
The Standard Toolbar

The Formatting Toolbar

When you point and pause on a button using the mouse, Excel will display its name in a ToolTip box. If
you then look at the bottom left corner of your screen you will see a short explanation of the button's
function displayed on the Status Bar.

Spreadsheets
The spreadsheet is divided into columns and rows, creating a grid of squares referred to as cells. The cell
that is highlighted by a darker border is referred to as the Active Cell and represents where data will
appear when you start to type.
Each column is identified by a letter reference: A, B, C,.... AA, AB, AC... etc. and each row by a number: 1,
2, 3 .... etc, giving each cell a unique reference corresponding to its position on the worksheet. For
example, the cell in the 4th column and 3rd row is cell D3.

Printing Spreadsheets
1.

Click on the print preview

2.

When you are satisfied, go back into the spreadsheet by clicking on the

3.

Select File from the menu bar. Select print within the file menu. Select OK within the print dialogue
box.

4.

From the menu bar select Tools. Within the tools menu select Options. The Options dialogue box will
be displayed.

5.

Select the View Tag & click on the Formula check box.

6.

Click on OK to return to the spreadsheet.

7.

Use print preview to check that the spreadsheet still fits
on the page, Adjust column width if necessary.

8.

Select File from the menu bar. Select print within the
file menu. Select OK within the print dialogue box.
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button.

EXERCISE 1 REGENT BEARINGS
During this exercise you will work towards creating a spreadsheet exactly the same as the one below. You
may need to refer to this diagram if any of the later steps seem unclear. However DO NOT attempt to
copy it.

Entering information into a cell
1.

Make the cell active cell by clicking the mouse pointer directly over the cell.

2.

Type in the contents required and Press return.

Centring text across cells
1.

To Select the Range hold down the mouse button in the first cell required and drag over to the last cell
required.

2.

e.g. To Select the Range of Cells from A1 to G1, Hold down the mouse button in cell A1 and drag
over to cell G1.

3.

Centre this by clicking on the merge cells

4.

Deselect the cell range by clicking anywhere on the worksheet with the left mouse button.

button.

EXERCISE 1 - STEP 1
1.

Use and centre across cells A1 to G1 the title Regent Bearings
Titles should appear in the centre of a spreadsheet and not affect column widths.

2.

Starting in cell A3 enter the following headings.
ITEM

3.

PRICE

COST

MADE

SOLD

INCOME

Starting in cell A5 enter the following titles, adjust the column width if necessary. This text should be
left justified.
Bearings
Washers 5m x 100
Nails 30mm x 100
Screws 30mm x 100
Bolts 5m x 100
Nails 20mm x 100
TOTALS

4.

Print out one copy

5.

Save your work as Exercise 1b
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Modifying column widths

1.

To modify the column width, move the mouse pointer on to the right edge of the column heading you
want to modify.
At this point

The mouse pointer will change to a double arrow.
2.

Hold and drag the mouse to the required position, or double click and Excel will increase the cell width
to accommodate the widest cell entry.

Cell Justification
1.

Select the range of cells required

2.

Adjust the cell justification is by clicking on one of the alignment
formatting toolbar.

3.

Enter the following data.

ITEM
Bearings
Washers M5 x 100
Nails 30mm x 100
Screws 30mm x 100
Bolts M5 x 100
Nails 20mm x 100
TOTALS
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PRICE
1.12
1.99
2.5
1
1
1.1

COST
0.87
1.35
1.9
0.65
0.65
0.66

73

icons. Found on the

MADE
30
20
20
10
60
50

SOLD
15
17
12
3
60
44

Changing the format of cells
1.

Select the range of cells that you wish to change the format of.

2.

Move the mouse pointer to the menu bar and click on FORMAT, now click on CELLS.
The Format Cells dialogue box will be displayed.

3.

Click on the tag called NUMBER

Number Tag
Sample Value

Adjusting
decimal
places

4.

Change the settings of this window to the same as the diagram shown. The sample value should be
set to 2 decimal places.

5.

Select OK to return to the spreadsheet.

Changing the contents of a cell
1.

Click in the cell containing the information to be changed

2.

This cells contents will appear in the formula bar.

3.

Click in the formula bar and make any corrections.

4.

Press return when done.

EXERCISE 1 - STEP 2
1.

Change the format of the cells containing the values for ‘PRICE’ and ‘COST’ to CURRENCY so that
the pound sign is displayed.

2.

Increase the price of Bolts 5m*100 to 1.10
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Entering simple formulas
1.

Click in the cell where you want the answer to be, In this case cell F5
The INCOME will
be the price
multiplied by the
number sold. So
the formula will be
B5*E5.
All formulas must start with an equals (=) symbol. To create this formula,

2.

Click on the formula bar.

3.

Press return.
The value 16.8 will appear as the income for Bearings.

4.

Replicate this formula to calculate the income made for each dish.

AutoFill
One quick way to copy this formula is to use the AutoFill feature. The AutoFill handle is located at the
bottom right corner of the active cell.
AutoFill handle
1.

Click the mouse in the cell that you wish to copy, cell F5 in this case

2.

Hold the mouse button on the AutoFill handle. Move the mouse pointer down to cover all the cells that
you wish to copy the formula to, in this case F10.

3.

Release the mouse button.

AutoSum
To quickly add a column or row of values, use Excel's AutoSum feature.
1.

Move to the cell where the total will appear. (Cell D12 in this exercise)

2.

Click on the AutoSum

button

Excel will indicate the range of cells to be included in the addition by surrounding them with a dotted
line.
3.

If the cell range shown is correct, click on the AutoSum

button a second time.

4.

If the cell range selected in incorrect, click and drag over the correct range, then click on the AutoSum
button a second time..

Deleting rows or columns
1.

Click on the row number or letter of the column you wish to delete with the mouse.

2.

From the menu bar select Edit.

3.

Within the Edit menu select Delete.
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EXERCISE 1 - STEP 3
1.

Generate the income obtained from Bearings by multiplying the price by the number sold, putting the
answer in the income column.

2.

Change the format of the cells containing the values for ‘PRICE’ and ‘COST’ to CURRENCY.

3.

Use a formula to calculate the total items made, total dishes sold and the total income. The value for
total made should be 190.

4.

Use the AutoSum feature to create the totals for items sold (should be 151) and income (should be
198.03) in the same way or use the AutoFill feature to copy this formula.

5.

Bolts 5m*100 has been withdrawn from the menu so delete this row.

6.

Add an extra column to the spreadsheet to show the profit made on each dish. Under the heading
PROFIT generate the data for each item using the formula
PROFIT = INCOME - (COST * MADE). Total this column to calculate the overall profit for all the
dishes, putting the answer in the totals row. See the notes below

7.

Use the AutoFill feature to copy this formula for the other dishes.

8.

Use the AutoSum feature to calculate the total profit. This should be 31.93

9.

Change the format of the cells where the Income & Profit values are, showing the pound symbol to two
decimal places.

10. Print out one copy
11. Save your work as Exercise 1a
First start by calculating the profit for Bearings. The profit for this dish should appear in cell G5 so click on
this cell. If this is done correctly the answer should be -9.3
Check your printout showing formulas with the diagram below.

EXERCISE 1 - STEP 4
1.

Check your answers and make any corrections required

2.

Print out one copy

3.

Save your work as Exercise 1b

4.

File the work in your portfolio
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Re-cap
During this first exercise you have covered the following features of Excel.
•
•
•
•
•
•
•
•
•

Title centring
Adjusting column width
Formatting a range of cells
Entering Formula
AutoFill
AutoSum
Deleting Rows
Printing
Viewing Formula

Check that you are familiar with each of the above, experimenting if necessary. Ask your instructor to
check you work and obtain the next exercise.

EXERCISE 2: SALES EXERCISE
During this exercise you will work towards creating this spreadsheet.
DO NOT START COPYING THIS DIAGRAM.

EXERCISE 2 - STEP 1
1.

On the top row enter the title SALES, centre this across the spreadsheet.

2.

Leaving a 1 row gap enter the following column headings. You may need to adjust column widths.
TRANSFORMERS

SWITCHES

SOCKETS

CABLE TRUNKING

DIODES

TOTAL

3.

Using the AutoFill feature, add weekdays to your spreadsheet.

4.

Complete the first column by adding the rows TOTAL, COST and EXPENDITURE to the spreadsheet.

5.

Fill in the spreadsheet with the figures as shown in the diagram below. At this point your spreadsheet
should look like this :-

6.

Print out one copy of your spreadsheet

7.

Save the work to your floppy disk using the name Exersice2
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EXERCISE 1 - STEP 4
1.

Use AutoSum & AutoFill to :a) Calculate the total sold on Monday. (This should be 161).
b) Replicate this formula to obtain the totals for the other days.
c)

Calculate the total of TRANSFORMERS sold during the week. (This should be 186).

d) Replicate this formula to obtain the totals for the other items.
2.

Change the format of the cells containing figures for COST to CURRENCY.

3.

Use a formula to calculate the weekly expenditure on each item.
EXPENDITURE = TOTAL SOLD * COST

4.

Change the format of the expenditure row to CURRENCY.

5.

The data for DIODES should not have been entered, delete the whole column.

6.

The cost of SWITCHES should be 13 pence.

7.

Insert a new row after Friday, and insert the following sales data.
SAT

8.

31

45

32

21

12

Adjust the spreadsheet to take into account the sales on Saturday and calculate the overall
expenditure for all the items. (This should be £152.07).
Check your spreadsheet with the one at the beginning of this exercise.

9.

Print out your spreadsheet showing both :a) Calculated Values
b) The Formulas

10. Save the work to your floppy disk using the name Exersice2a.
11. File your work in your portfolio.
 Grimsby College

78

Creating Charts
Excel provides a useful facility to allow you to create graphs from raw data on the spreadsheet. Excel
refers to all types of graph ( bar, line, pie etc. ) as charts.
The following areas will be looked at :•

Organising the Spreadsheet

•

Using ‘Chart Wizard’

•

Printing a Chart

Organising the Spreadsheet
It is important to look at what characteristics a spreadsheet should have in order to produce good charts.
The secret of success in chart production is to ensure that the spreadsheet you use is correctly laid out,
and that you select (highlight) the right parts of it.
To do this the spreadsheet must be laid-out in a tight ‘block’ like this.

Guidelines
•

Keep the cell at the top left of the block empty.

•

Do not leave blank rows or columns within the block.
Before creating a chart, you must select the area of your spreadsheet which contains the information
you want to display. You should select only this block of cells (See diagram above). This avoids
distorting the chart with other cells such as titles.
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Entering Data
Before any charts can be created, input the following data into a spreadsheet. Use formulas to calculate
the values in the totals row.

Creating Charts using ‘Chart Wizard’
Excels Chart Wizard facility enables you to design and create charts quickly and easily, by taking you
through four simple steps.
1.

Specify which area of the spreadsheet you wish to use to create the chart.
To do this highlight (Select) the block of cells from A6 to G11 on your spreadsheet.

2.

Click on the Chart Wizard

button on the Toolbar.

The first dialogue box appears, displaying the types of chart available.
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3.

To do this:
Select the column chart and the top left chart sub-type

4.

Click on Next.
The second dialogue box appears displaying different ways of presenting the graph.

5.

Select to show the data series in columns.

6.

Click on Next.
The last dialogue box appears, this allows you to modify the titles for the chart. Make the dialogue box
like the one shown below.

Type in the Chart title: box Humber Bridge Crossing
Type in the Category (x) axis: box Category of Vehicle
Type in the Value (y) axis: box Thousands
Select Next to see the Place chart dialogue box..
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7.

Select Finish to see the chart in your spreadsheet.

Re-sizing charts
To re-size the graph, do the following:
1.

Highlight the graph by clicking in the centre.
When you do this you will see that the picture is surrounded by 8 small boxes, called handles.

2.

Move the pointer near to one of the corner handles until the pointer changes into a diagonal arrow like
this . When this happens it means that the pointer is in the correct position to re-size that graph.

Handle
3.

Hold down the mouse button and move nearer or further to the picture, thus altering the size.

4.

Release the mouse button at the desired size.
NB by clicking or double clicking on an object in a graph, whether text or graphics you will be able to
move or resize it. Try this out to change the appearance of your graph.

5.

Use Excel to make the graph look line this,
Humber Briidge Crossing

Thousands

4500
4000

1987-88

3500

1987-89

3000

1987-90

2500

1987-91

2000

1987-92
1987-93

1500
1000
500
0
Heavy
Comerscial

Light
Comercial

Busses

Motor
Cycles

Category of Vehicle
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Cars

Printing a Chart
Before actually printing a chart (or anything) it is a good idea to use the Print Preview facility. This will
allow you to see how the print-out would look, without having to print it out.
To use Print Preview
1.

Highlight the area that you wish to print. In this case print all the text & the chart, like this.

2.

Click the print preview

button.

You will see an example of how the printout will look.
3.

Select the Print button on this screen.

4.

So that the computer will only print out the highlighted area, make sure that the Selection option is
chosen at the “print what” screen.

Select the Selection option

5.

Click on the Preview button to return to the print preview screen
At the bottom right hand side of the screen, the computer will indicate how many pages the print-out is
expected to take.
If this reads PAGE 1 OF 1 then select the print button again to print out your work onto 1 page.
If the print-out is expected to take more pages then it will be necessary to use the Set-up screen to
make a few changes to the print settings.
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To change the print settings
1.

At the print preview screen, click on the set-up button.
The set-up screen will be displayed.
Layout

Page

Size

2.

Try changing the Orientation to Landscape or adjust the scaling size.

3.

Click OK to return to the print preview screen.
It may be necessary to adjust these settings and return to the print preview/set-up screens several
times before you are able to fit the print-out onto 1 page.

EXERCISE 3: COIL ANALYSIS
During this exercise you will create a spreadsheet including a chart, illustrating the variations of resistance
values over 1 week.
For this exercise you will be asked to use your judgement about how to organise the spreadsheet and what
type of chart would be most suitable to show this data.
To get the most out of this learning exercise take your time and plan your work carefully. You will need to
use extra functions as you see fit, these are not be mentioned in the steps below. However they have
been mentioned in earlier exercises.
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Organizing the Spreadsheet

EXERCISE 3 - STEP 1
1.

Start Excel

2.

Create a Title for this exercise.

3.

Create the following column headings
Date

Time

Coil type

Resistance Value,

4.

Fill in the Dates column at daily intervals over a 6 day period.

5.

Fill the columns in with values that are realistic for the type of coil you are analysing

6.

Print out one copy of your work

7.

Save your work to your floppy disk under the name Exercise 3

8.

Create three rows at the bottom of the spreadsheet headed,
MAX
MIN
AVERAGE

9.

Enter formulae into these three rows to calculate their values from the data above.
You will need to use Excels Help
feature to find out how to do this. You can access this by
clicking on the help icon or clicking on Help on the menus bar and then

Creating Charts

EXERCISE 3 - STEP 2
1.

Create a chart of a suitable type to show varying resistance values of the various types of coils over
the 1 week period.

2.

Your chart should have a suitable heading, with the horizontal (x) and vertical (y) axis clearly labelled.

3.

Save the spreadsheet & chart to your floppy disk as Exercise 3.

4.

Print one copy of the spreadsheet & chart in colour if available.

5.

Make sure this fits onto one page.

6.

Print one copy of your spreadsheet showing the formulas used.

7.

Make sure this is print out is in landscape and fits onto one page.

8.

File the work in your portfolio.
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INFORMATION TECHNOLOGY
KEY SKILLS STAGE 3
SPREADSHEET BUILD UP TASK

MIGHTY PACKERS PLC
You work for a company that packs crisps for wholesale markets and supermarkets.
You are responsible for the administration of the business which includes working out and making up the
wages for the people who work in the packhouse sorting and packing the crisps.
You have decided that, in order to save time, you will build a spreadsheet on a computer to help work out
the wages. You are going to work out the wages for two weeks.
Have a look at
14 January 2000.

the

hours

worked

each

day

for

each

person,

NAME

TOTAL

ALLOWANCE

REG SMITH
SAM POOLE
GEORGE DUNCAN
JESSIE ROSS
BECKY SMITH
JOHN SHERWIN
JOHN SCOTT
PETER JACOB
GWEN ROBERTS
KIERAN O’HARA

46½
46
46½
46
40
47¼
44¾
45
32
46

£82.22
£53.38
£84.22
£53.38
£53.38
£91.15
£84.22
£63.13
£44.98
£84.22

for

the

week

ending

WEEK ONE
Hours and Wage Rates
The company considers that 40 hours is a reasonable number of hours to work each week.
Basic hours = up to 40 hours worked per week. These hours are paid at the basic rate of £4.00 per hour.
Overtime hours = hours worked excluding the 40 hours. These are paid the overtime rate of £5.50 per
hour.
Work out the number of basic and overtime hours worked by each person for the week ending 14 January
2000.
We will now start to build the spreadsheet to work out the following for each person:
Number of Basic Hours
Number of Overtime Hours
Gross Wage (total amount of money due for all hours worked)
Key in the Heading MIGHTY PACKERS PLC in Cell A1
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Underneath this heading key in the following Column Headings:
Column A
Column B
Column C
Column D
Column E
Column F
Column G
Column H

-

NAME
BASIC HRS
NO OF OVERTIME HRS
GROSS WAGE
ALLOWANCE
TAX DUE
NI DUE
NET PAY

Key in the Employee names underneath
the NAME heading in Column A
Key in the Basic and Overtime Hrs
above for each person. Remember to
split the Basic Hrs (40 hrs) from the
Overtime Hrs (anything over 40 hrs).
Key in the Tax Allowance from the list
above in the ALLOWANCE Column
Include the two wage rates in a variable
table at the top of the spreadsheet and
refer to them from within.
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Tax
Everybody must pay tax to the government on the wages that they earn. This is called Income Tax. There
are two aspects to income tax:
A.

B.

You do not have to pay this tax on all of your wages – you have an allowance or free pay on which
no tax is charged. Please see the Time Sheets for the amount of money on which the individual is
charged no tax.
Any wages earned over and above the allowance have 25% deducted in tax.

Extend the spreadsheet to include the allowance and also the tax to be deducted for each person. See the
examples below to locate the formula to be used.
Include the tax rate of 25% in the variable table at the top of the spreadsheet.

National Insurance
This is another deduction made by the government. It is payable on all your gross earnings. We will
assume for this task that the current rate of National Insurance is 2% on earnings up to £43 plus 9% on
earnings over £43. Include these NI rates in the variable table at the top of the spreadsheet. Extend the
spreadsheet to include the amount of NI due for each person. See the example below to locate the formula
to be used
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NET PAY
To work out the Net Pay you will need to
locate the Gross Pay and minus the Tax
and minus the NI:
=(Gross Pay-Tax)-NI

TOTALS FOR COLUMNS
1.

Click in the blank cell below the first column you require a total for, ie, basic hrs

2.

Highlight all the figures in that column including the blank cell in which the answer will appear

3.

Click on the autosum icon on the top Toolbar twice –

Once to show the formula you are creating
Twice to display the answer
Repeat step 3 until you have totals at the bottom of the following columns:

Overtime Hrs
Gross Pay
Allowance
Tax
NI
Net Pay
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SAVING SPREADSHEETS
1.

Click on the File Menu

2.

Choose Save or Save As from the
list

3.

Key in an appropriate filename, ie
Mighty Packers

4.

Click on the Save Icon
Or

1.

Click on the Save Icon on the top
rd
Toolbar (3 Icon from left – black
disk)

2.

Follow steps 3 and 4 from above
to save the work

CHANGING PAGE ORIENTATION
Should your spreadsheet not fit on to
one page on Portrait, it can be changed
to print on Landscape:
1.

Click on File

2.

Choose Page Setup
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3.

Click on the Page Tab at the top of
the window

4.

Click on Landscape

5.

Click on OK or Print if you are
wishing to print now

PRINTING SPREADSHEETS
1.

Click on the File Menu

2.

Choose Print from the list

3.

Specify the number of pages you
wish to print or choose All

4.

Click on the Print button at the
bottom of the window
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PRINTING FORMULAS
Should you wish to keep a copy of the
formulas used within a spreadsheet
follow the steps below:
1.

Click on the Tools Menu

2.

Choose Options from the bottom of
this list

3.

Click on the Formulas option at the
bottom left corner of this window to
create a tick

4.

Click on OK

Your spreadsheet will now
formulas rather than answers
5.

display

You can print your work in the
normal way if you require a hard
copy of the formulas

Or
6.

You can save your work again with
a new filename by:
a.
b.
c.
d.

Clicking on the File Menu
Choose Save As from the list
Key in a new filename
Click on Save

AUTOFIT COLUMNS
Sometimes you may have a fairly large
spreadsheet and you need it to fit to
one page.
1.

Highlight the whole spreadsheet
by clicking on the blank grey box
at the left of the screen (above row
1 and next to Col A)

2.

Click on the Format Menu

3.

Choose Column from the list

4.

Choose AutoFit Selection

Your spreadsheet will now fit the page
ready to print
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AUTOFIT ROWS
1.

Repeat procedures 1 & 2 above

2.

Choose Row from the list

3.

Choose AutoFit

Or
1.

Click on the File Menu

2.

Choose Page Setup from the list

3.

Click on the Page Tab at the top
of this menu

4.

Click on the option – Fit to 1 page

5.

Click on OK

CHANGING AN EXISTING
SPREADSHEET
DELETING EMPLOYEES
George Duncan and John Sherwin
have left the company and need to be
removed from the spreadsheet for the
next week:
1.

Click and drag down on the
row numbers alongside George’s
and John’s name, this will highlight
the rows

2.

Click on the Edit Menu

3.

Choose Delete from the list
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George, John and the blank rows will
have disappeared. Any data below this
has now moved up in its place.

A new Tax Rate has been introduced.
29% will replace the 25% tax rate last
week:
Click in to the Tax Rate Cell (C3) and
re-type the new rate of 29%

You will notice that because all
employees’ pay is connected to cell C3,
the Tax and Net Pay columns change
accordingly to accommodate the
increase.
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All employees worked different hours this week as shown below:
NAME

TOTAL

ALLOWANCE

REG SMITH
SAM POOLE
JESSIE ROSS
BECKY SMITH
JOHN SCOTT
PETER JACOB
GWEN ROBERTS
KIERAN O’HARA

46
46
46
38½
48
45
32
46

£82.22
£53.38
£53.38
£53.38
£89.20
£63.13
£44.98
£84.22

1. Amend your spreadsheet to
accommodate the changes and
check your answers with the
example shown:

2. Print a copy of both the main
spreadsheet and the formulas
REMEMBER
WORK
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
ENGLISH LAW
STATUTORY AND OTHER PROVISIONS OF ENGLISH LAW
Whilst the use of the Internet is a broadly unregulated medium, there are a number of statutory and other
legal provisions which may impact upon its use. The following are a selection of provisions for which users
of the Internet will need to be cognisant; they are, however, by no means exhaustive.
COMPUTER MISUSE ACT 1990
The Computer Misuse Act 1990 makes it a criminal offence to access, or attempt to access computer
material without proper authority or to make unauthorised modification of computer material. Persons
convicted of an offence under the Computer Misuse Act are subject to a maximum of 5 years'
imprisonment or a fine or both. In the context of Internet use, it is likely that the following examples would
be considered illegal.
•
•
•
•
•

Accessing restricted material without proper authority.
Provision of any material, such as access codes or 'hacking' instructions which enables others to gain
unauthorised access to a computer system.
Knowingly receiving (or using) any material from an unauthorised user who has gained access to
systems.
Unauthorised modification of a computer system program or data stored on a system.
Any material, which encourages or incites other persons to carry out unauthorised access or
modification of a computer system, program or data.

THE COPYRIGHT DESIGNS AND PATENTS ACT 1988
It is an offence under this Act to copy software or other Internet materials without authority It is immaterial
whether such unauthorised copying is done with a view to personal convenience or for monetary gain.
Unlimited fines and up to two years' imprisonment may be imposed on offenders.
All software, including commercial products and Shareware, is protected by copyright law and is licensed
for legitimate use. Some software creators have designated their products as Freeware (for which use is
authorised without a licence fee being payable) and have made this available on the Internet.
DATA PROTECTION ACT 1984
This Act prohibits the holding, processing or disclosure of personal information data about others on
computer, unless the data user is properly registered and observes the data protection principles.
RACE RELATIONS AND SEXUAL DISCRIMINATION ACTS.
Discrimination on the grounds of race, colour, nationality, ethnic or national origin or gender is unlawful
under the provisions of the above legislation. Any material published or received via the Internet (or by
other means) which discriminates or encourages discrimination is in contravention of the legislation.
OFFICIAL SECRETS ACTS
The provisions of this legislation often apply in connection with contracts with the Government or
government agencies. Any publication of material via the Internet (or by any other means) which is in
contravention of obligations under the Official Secrets Acts is a criminal offence, which is punishable by
imprisonment or a fine or both.
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CRIMINAL JUSTICE AND PUBLIC ORDER ACT 1994
This miscellany of legislation includes a consolidation of provisions for the protection of minors by making it
a criminal offence to possess pornographic or obscene material of or involving minors, or material
considered being excessively violent. In the context of the Internet it would apply to the transmission,
receipt and storage of text, audio and graphic images.
LAWS OF DEFAMATION
Any publication of a statement, comment or innuendo about another individual or organisation, which
cannot be justified at law, may render the author liable to an action for defamation.
OBSCENE PUBLICATIONS ACT 1959
The publication (whether for gain or not) of material intended to be read, heard or looked at which is such
as to tend to deprave and corrupt persons having access to the publication is a criminal offence which
carries a maximum sentence of three years imprisonment.
TELECOMMUNICATIONS ACT 1984
A person who sends a message or other matter that is grossly offensive, indecent, obscene or menacing in
character via the public telecommunication system or sends a false message for the purpose of causing
annoyance, inconvenience or needless anxiety to another shall be guilty of a criminal offence. The Internet
makes use of the "public telecommunication system". A breach of this Act will result in a substantial fine
and/or imprisonment.
INTERNATIONAL LAW
Users of the Internet should be aware that any material, which they create and transmit, is accessible
world-wide and that such material must not therefore contravene any international laws or treaties. Specific
examples include the importation of specified material from countries for which an embargo is in force and
the possibilities that material lawfully provided in the United Kingdom but accessed in another country may
constitute an offence within that recipient country.
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
A GUIDE TO COPYRIGHTS
WHAT IS A COPYRIGHT
Copyright is a form of protection provided by the laws of the United States (title 17, U.S. Code) to the
authors of "original works of authorship " including literary, dramatic, musical, artistic, and certain other
intellectual works. This protection is available to both published and unpublished works. The Copyright Act
generally gives the owner of copyright the following exclusive rights:
•
•
•
•
•

To reproduce the copyrighted work in copies or recordings;
To prepare derivative works based upon the copyrighted work;
To distribute copies or recordings of the copyrighted work to the public by sale or other transfer of
ownership, or by rental, lease, or lending;
To perform the copyrighted work publicly, in the case of literary, musical, dramatic, and choreographic
works, pantomimes, motion pictures and other audio-visual works; and
To display the copyrighted work publicly, in the case of literary, musical, dramatic, and choreographic
works, pantomimes, and pictorial, graphic, or sculptural works, including the individual images of a
motion picture or other audio-visual work.

WHO CAN CLAIM COPYRIGHT?
In the case of works made for hire, the employer and not the employee is presumptively considered the
author. The copyright statute defines a "work made for hire" as:
•
•

A work prepared by an employee within the scope of his or her employment; or
Certain works specially ordered or commissioned, if the parties expressly agree in a written instrument
signed by them that the work shall be considered a work made for hire.

The authors of a joint work are co-owners of the copyright in the work, unless there is an agreement to the
contrary.
Copyright in each separate contribution to a periodical or other collective work is distinct from copyright in
the collective work as a whole and vests initially with the author of the contribution.
Mere ownership of a book, manuscript, painting, or any other copy or recording does not give the
possessor the copyright. The law provides that transfer of ownership of any material object that embodies
a protected work does not of itself convey any rights in the copyright.
WHAT WORKS ARE PROTECTED?
Copyright protection exists for "original works of authorship" when they become fixed in a tangible form of
expression. Copyright able works include the following categories:
•
•
•
•
•
•
•
•

written literary works;
musical works, including any accompanying words;
dramatic works, including any accompanying music;
pantomimes and choreographic works;
pictorial, graphic, and sculptural works;
motion pictures, video recordings and other audio-visual works;
sound recordings; and
computer software.

This list is illustrative and is not meant to exhaust the categories of copyright able works. These categories
are viewed quite broadly.
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WHAT IS NOT PROTECTED BY COPYRIGHT?
Several categories of material are generally not eligible for statutory copyright protection. These include
among others:
•

Works that have not been fixed in a tangible form of expression. For example: choreographic works,
which have not been noted or recorded or improvisational speeches or performances that have not
been written or recorded.

•

Titles, trademarks, names, short phrases, and slogans; familiar symbols or designs; mere variations of
typographic ornamentation, lettering, or colouring; mere listings of ingredients or contents.

•

Ideas, procedures, methods, systems, processes, concepts, principles, discoveries, or devices, as
distinguished from a description, explanation or illustration.

•

Works consisting entirely of information that is common property and containing no original authorship.
For example: standard calendars, height and weight charts, tape measures and rules, and lists or
tables taken from public documents or other common sources.

HOW TO SECURE A COPYRIGHT
Copyright is secured automatically upon creation.
The way in which copyright protection is secured under the present law is frequently misunderstood. No
publication or registration or other action in the Copyright Office is required to secure copyright. Copyright
is secured automatically when the work is created in tangible form for the first time.
There are, however, certain definite advantages to registration.

NOTICE OF COPYRIGHT
When a work is published under the authority of the copyright owner, a notice of copyright should be
placed on all publicly distributed copies and on all publicly distributed sound recordings. This notice is
required even on works published outside of the United States. Failure to comply with the notice
requirement can result in the loss of certain additional rights otherwise available to the copyright owner.
The use of the copyright notice is the responsibility of the copyright owner and does not require advance
permission from, or registration with, the Copyright Office.
Form of Notice for Visually Perceptible Copies
The notice for visually perceptible copies should contain all of the following three elements:
•
•
•

The symbol comprising the letter C in a circle, the word "Copyright " or the abbreviation "Copr.”
The year of first publication of the work.
The name of the owner of copyright in the work, or an abbreviation by which the name can be
recognised, or a generally known alternative designation of the owner.
• Example: © 1995 John Doe
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Form Of Notice for Sound Recordings
The copyright notice for sound recordings has somewhat different requirements. The notice should contain
the following three elements:
•
•
•

The symbol comprising the letter P in a circle;
The year of first publication of the sound recording; and
The name of the owner of copyright in the sound recording, or an abbreviation by which the name can
be recognised, or a generally known alternative designation of the owner. If the producer of the sound
recording is named on its labels or containers, and if no other name appears in conjunction with the
notice, the producer's name shall be considered a part of the notice.

Position Of Notice
The notice should be placed on all copies or recordings of the work in such a manner and location as to
"give reasonable notice of the claim of copyright." The notice of recordings may appear on the surface of
the recording or on its label or container, provided the manner of placement and location gives reasonable
notice of the claim. The three elements of the notice should ordinarily appear together on the copies or
recordings.
Unpublished Works
The copyright notice is not required on unpublished works. To avoid an inadvertent publication without
notice, however, it may be advisable for the author or other owner of the copyright to place a copyright
notice, or a statement such as "Unpublished Work, Copyright 1984 John Doe" on any copies or recordings
which leave his or her control.

HOW LONG DOES COPYRIGHT PROTECTION ENDURE?
A work created (fixed in tangible form for the first time) on or after January 1, 1978 is automatically
protected from the moment of its creation, and is ordinarily given a term enduring for the author's life, plus
an additional 50 years after the author's death.

TRANSFER OF COPYRIGHT
Any or all of the exclusive rights of the copyright owner may be transferred, but the transfer of exclusive
rights is not valid unless it is in writing and signed by the owner of the rights conveyed. Transfer of a right
on a nonexclusive basis does not require a written agreement.

COPYRIGHT REGISTRATION
In general, copyright registration is a legal formality intended to make a public record of the basic facts of a
particular copyright. However, except in two specific situations, registration is not a condition of copyright
protection.
Even though registration is not generally a requirement for protection, the copyright law provides several
inducements or advantages to encourage copyright owners to make registration. Among these advantages
are the following:
•
•
•
•

Registration establishes a public record of the copyright claim;
Registration is ordinarily necessary before any infringement suits may be filed in court;
If made before or within 5 years of publication, registration will establish evidence in court of the
validity of the copyright; and
If registration is made within 3 months after publication of the work or prior to an infringement of the
work, statutory damages and attorney's fees will be available to the copyright owner in court actions.
Otherwise, only an award of actual damages and profits is available.
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Registration may be made at any time within the life of the copyright. To assure that you have full legal
rights for enforcement of your copyright you should file for registration within 3 months after your work is
first published and be certain that all published copies carry a copyright notice.

INTERNATIONAL COPYRIGHT PROTECTION
There is no such thing as an "international copyright" that will automatically protect an author's writings
throughout the entire world. Protection against unauthorised use in a particular country depends, basically,
on the national laws of that country. However, most countries do offer protection to foreign works under
certain conditions, and these conditions have been greatly simplified by international copyright treaties and
conventions.

Portions of "A Guide to Copyrights" were excerpted and edited from the following U.S. Government
publication:
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
DATA PROTECTION ACT 1984
WHY HAVE DATA PROTECTION?
The Data Protection Act 1984 grew out of public concern about personal privacy in the face of rapidly
developing computer technology. It provides new rights for individuals and demands good computer
practice in handling information about people.
The Act also enabled the United Kingdom to ratify the Council of Europe Convention on Data Protection
allowing data to flow freely between the United Kingdom and other European countries with similar laws,
preventing damage to the economy and international trade which might otherwise have occurred.
WHAT DOES THE ACT COVER?
The Data Protection Act is administered by the Data Protection Registrar, an independent officer who
reports directly to Parliament and in essence, the Act is concerned with 'personal data' which is
'automatically processed'. It works in two ways, giving individuals certain rights whilst requiring those who
record and use personal information on computer to be open about that use and to follow sound and
proper practices.
•
•

Personal Data – is information about living, identifiable individuals. This need not be particularly
sensitive information, and can be as little as a name and address.
Automatically processed – means, broadly speaking, information which is processed by computer. it
does not cover information which is held and processed manually, eg. in ordinary paper files.

To fully understand the Act, you will need to know two further Data Protection definitions:
•
•

Data users – those who control the contents and use of a collection of personal data. This can be any
type of company or organisation, large or small, within the public or private sector. A data user can
also be a sole trader, partnership, or an individual. A data user need not necessarily own a computer.
Data subjects – the individuals to whom the personal data relate.

WHAT DOES DATA PROTECTION MEAN TO ME?
•

Subject Access – The Data Protection Act allows you to have access to information held about
yourself on computer and where appropriate to have it corrected or deleted. This is known as the
'subject access right' and it means that you are entitled, on making a written request to a data user, to
be supplied with a copy of any personal data held about you. The data user may charge a fee of up to
£10 for each register entry for supplying this information but in some cases it is supplied free. Usually
your request must be responded to within 40 days. If not, you are entitled to complain to the Registrar
or to apply for a court order for access. If personal data are found to be inaccurate you may complain
to the Registrar or apply to the Courts for correction or deletion of the data.

•

Access to the Register – The Data Protection register is open to public inspection at the Registrar's
office in Wilmslow. Copies of individual register entries are available free of charge (a small fee is
payable for certified copies). A register entry only shows what a data user is registered to do, it does
not reveal whether or not that data user holds personal information about you.

•

Complaints to the Registrar – If you consider there has been a breach of one of the Principles (or
any other provision of the Act), you are entitled to complain to the Data Protection Registrar. If the
Registrar considers the complaint is justified and cannot be resolved informally then he may decide to
prosecute or to serve an enforcement notice or notice of refusal of registration on the data user in
question.
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•

Compensation – You care entitled to seek compensation through the Courts if damage (not just
distress) has been caused by the loss, or unauthorised destruction or disclosure of your personal data.
'Unauthorised' means without the authority of the data user or computer bureau concerned. If damage
is proved, then the Court may also order compensation for any associated distress. You may also seek
compensation through the Courts for damage caused by inaccurate data.

Further information about your rights as an individual under the Data Protection Act is contained in the
leaflet 'If there's a mistake on computer about you' available free from the Data Protection Registrar's
Office.
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
THE DATA PROTECTION ACT 1998

Crown copyright 1998 with the
permission of the Controller of Her
Majesty’s Stationery Office.

The Data Protection Act 1998 came into force, 1 March 2000. It sets rules for processing personal
information and applies to paper records as well as those held on computers.
The Data Protection Act is supervised by the Data Protection Commissioner, who is currently Elizabeth
France.

HISTORY
What does the 1984 Act cover?
The Data Protection Act is concerned with “Personal Data” (this is information about living, identifiable
individuals. This need not be particularly sensitive information, and can be as little as name and address)
which is “automatically processed”. It works in two ways, giving individuals certain rights whilst requiring
those who record and use personal information on computer to be open about that use and to follow sound
and proper practices.
The Data Protection Act 1984 was the first piece of legislation to regulate the use of automatically
processed information – broadly speaking, information which is processed on computer. The Act grew out
of public concern about personal privacy in the face of rapidly developing computer technology. It does not
cover information which is held and processed manually in ordinary paper files, but does cover such
developments as laptop and notepad computers, smart cards, and optical image processors. However,
not all computerised information is covered, only that which relates to living individuals.
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Investigate the Data Protection Act 1998 and write a report detailing your findings. Incorporate as many of
your IT skills as possible.
Below are examples of some of the areas your report may cover:
•
•
•
•
•
•

Data Protection Principles
How to make a Subject Access request
Complaints to the Commissioner
Transfer of Data Overseas
The current Commissioner’s duties
The differences between the 1984 Act and the 1998 Act

You could find the following contacts useful:
www.dataprotection.gov.uk
The Office of The Data Protection Commissioner
Wycliffe House
Water Lane
WILMSLOW
Cheshire
SK9 5AF
Enquiries 01625 545 745
e-mail: data@wycliffe.demon.co.uk
Proof read all work thoroughly. Save your work in an appropriate place so that it can be retrieved at a later
date.
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
HOW COMPUTER VIRUSES WORK
Computer Viruses are mysterious and they also get your attention. Every time a new virus hits, it makes
the news if it spreads quickly. On the one hand viruses show us how unknowingly vulnerable we are, but
on the other hand they show how sophisticated and interconnected human beings have become. For
example, the "Melissa" virus - which became a world-wide phenomenon in March of 1999 - was so
powerful that it forced Microsoft and a number of other very large companies to completely turn off their
email systems until the virus could be contained. That's pretty impressive when you consider how simple
the Melissa virus was!
WHY IS IT CALLED A "VIRUS"?
Computer viruses are called "viruses" because they share some of the traits of biological viruses. A
computer virus passes from computer to computer like a biological virus passes from person to person, for
example.
At a deeper level there are similarities as well. A biological virus is not a living thing. A virus is a fragment
of DNA inside a protective jacket. Unlike a cell, a virus has no way to do anything or to reproduce by itself
- it is not alive. Instead, a biological virus must inject its DNA into a cell. The viral DNA then uses the cell's
existing machinery to reproduce itself. In some cases the cell fills with new viral particles until it bursts,
releasing the virus. In other cases the new virus particles bud off the cell one at a time and the cell
remains alive.
A computer virus shares some of these traits. A computer virus must piggyback on top of some other
program or document in order to get executed. Once it is running, it is then able to infect other programs
or documents. Obviously the analogy between computer and biological viruses stretches things a bit, but
there are enough similarities that the name sticks.
VIRUS HISTORY
Computer Viruses were first widely seen in the late 1980s, and they came about because of several
factors. The first factor was the spread of personal computers. Prior to the 1980s, home computers were
non-existent or they were toys. Real computers were rare and they were locked away for use by "experts".
During the 1980s, real computers started to spread to businesses and homes because of the popularity of
the IBM PC (released in 1982) and the Apple Macintosh (released in 1984). By the late 1980s PCs were
widespread in businesses, homes and college campuses.
The second factor was the use of computer "bulletin boards". People could dial up a bulletin board with a
modem and download programs of all types. Games were extremely popular, and so were simple word
processors, spreadsheets, etc. Bulletin boards led to the precursor of the virus known as the Trojan
Horse. A Trojan horse is a program that sounds really cool when you read about it. So you download it.
When you run the program, however, it does something uncool like erasing your disk. So you think you
are getting a neat game but it wipes out your system. Trojan horses only hit a small number of people
because they are discovered quickly. Either the bulletin board owner would erase the file from the system
or people would send out messages to warn one another.
The third factor that led to the creation of viruses was the floppy disk. In the 1980s programs were small
and you could fit the operating system, a word processor (plus several other programs) and some
documents onto a floppy disk or two. Many computers did not have hard disks, so you would turn on your
machine and it would load the operating system and everything else off of the floppy disk.
Viruses took advantage of these three facts to create the first self-replicating programs!

How Viruses Work
Early viruses were pieces of code attached to a common program like a popular game or a popular word
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processor. A person might download an infected game from a bulletin board and run it. A virus like this is a
small piece of code embedded in a larger, legitimate program. Any virus is designed so it runs first when
the legitimate program gets executed. The virus loads itself into memory and looks around to see if it can
find any other programs on the disk if it can find one it modifies it to add the virus's code to the
unsuspecting program. Then the virus launches the "real program". The user really has no way to know
that the virus ever ran. Unfortunately, the virus has now reproduced itself, so two programs are infected.
The next time either of those programs gets executed, they infect other programs, and the cycle continues.
If one of the infected programs is given to another person on a floppy disk, or if it is uploaded to a bulletin
board, then other programs get infected. This is how the virus spreads.
The spreading part is the "infection" phase of the virus. Viruses wouldn't be so violently despised if all they
did was replicate themselves. Unfortunately most viruses also have some sort of destructive "attack" phase
where they do some damage. Some sort of trigger will activate the attack phase, and the virus will then "do
something" - anything from printing a silly message on the screen to erasing all of your data. The trigger
might be a specific date, or the number of times the virus has been replicated, or something similar.
As viruses got more sophisticated, they learned new tricks. One important trick was the ability to load
themselves into memory so they could keep running in the background as long as the computer remained
on. This gave viruses a much more effective way to replicate themselves. Another trick was the ability to
infect the boot sector on floppy disks and hard disks. The boot sector is a small program that is the first
part of the operating system that the computer loads. The boot sector contains a tiny program that tells the
computer how to load the rest of the operating system. By putting its code in the boot sector, a virus can
guarantee it gets executed. It can load itself into memory immediately and it is able to run whenever the
computer is on. Boot sector viruses can infect the boot sector of any floppy disk inserted in the machine,
and on college campuses where lots of people share machines they spread like wildfire.
In general, both executable and boot sector viruses are not very threatening any more. The first reason for
the decline has been the huge size of today's programs. Nearly every program you buy today comes on a
compact disc. Compact discs cannot be modified, and that makes viral infection of a CD impossible. The
programs are so big that the only easy way to move them around is to buy the CD. People certainly can't
carry applications around on a floppy disk like they did in the 1980s, when floppies full of programs were
traded like baseball cards. Boot sector viruses have also declined because operating systems now protect
the boot sector.
Both boot sector viruses and executable viruses are still possible, but they are a lot harder now and they
don't spread nearly as fast as they once could. Call it "shrinking habitat", if you want to use a biological
analogy. The environment of floppy disks, small programs and weak operating systems made viruses
possible in the 1980s, but that environmental niche has been largely eliminated by huge executables,
unchangeable CDs and better operating system safeguards.

Macro Viruses
The latest thing is the macro virus, and the Melissa virus in March of 1999 was spectacular. Melissa
spread in Microsoft Word documents sent via email, and it worked like this. Someone created the virus as
a Word document uploaded to an Internet newsgroup. Anyone who downloaded the document and opened
it would trigger the virus. The virus would then send the document (and therefore itself) in an email
message to the first 50 people in the person's address book. The email message contained a friendly note
that included the person's name, so the recipient would open the document thinking it was harmless. The
virus would then create 50 new messages from the recipient's machine. As a result, the Melissa virus was
the fastest-spreading virus ever seen! As mentioned earlier, it forced a number of large companies to shut
down their email systems.
The Melissa virus took advantage of the programming language built into Microsoft Word called VBA, or
Visual Basic for Applications. It is a complete programming language and it can be programmed to do
things like modify files and send email messages. It also has a useful but dangerous auto-execute feature.
A programmer can insert a program into a document that runs instantly whenever the document is opened.
This is how the Melissa virus was programmed. Anyone who opened a document infected with Melissa
would immediately activate the virus. It would send the 50 emails, and then infect a central file called
NORMAL.DOT so that any file saved later would also contain the virus! It created a huge mess.
Microsoft applications have a feature called Macro Virus Protection built in to them to prevent this sort of
thing. If you turn Macro Virus Protection on, then the auto-execute feature is disabled. By default the option
is ON. So when a document tries to auto-execute viral code, a dialog pops up warning the user.
Unfortunately, many people don't know what macros or macro viruses are, and when they see the dialog
they ignore it. So the virus runs anyway. Many other people turn off the protection mechanism. So the
Melissa virus spread despite the safeguards in place to prevent it.
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Why do people create viruses?
People create viruses. A person has to write the code, test it to make sure it spreads properly and then
release the virus. A person also designs the virus's attack phase, whether its a silly message or destruction
of a hard disk. So why do people do it?
There are probably at least three reasons. The first is the same psychology that drives vandals and
arsonists. Why would someone want to bust the window on someone else's car, or spray paint signs on
buildings or burn down a beautiful forest? For some people that seems to be a thrill. If that sort of person
happens to know computer programming, then he or she may funnel energy into the creation of destructive
viruses.
The second reason has to do with the thrill of watching things blow up. Many people have a fascination
with things like explosions and car wrecks. When you were a kid there was probably a boy in your
neighbourhood who learned how to make gunpowder and who then built bigger and bigger bombs until he
either got bored or did some serious damage to himself. Creating a virus that spreads quickly is a little like
that - it creates a bomb inside a computer, and the more computers that get infected, the more "fun" the
explosion.
The third reason probably involves bragging rights, or the thrill of doing it. Sort of like Mt. Everest. The
mountain is there and no one has climbed it, so someone is compelled to do it. If you are a certain type of
programmer and you see a security hole that could be exploited, you might simply be compelled to exploit
the hole yourself before someone else beats you to it. "Sure, I could TELL someone about the hole. But
wouldn't it be better to SHOW them the hole?" That sort of logic leads to many viruses.
Of course, all of the virus creators miss the point that they cause real damage too real people with their
creations. Destroying everything on a person's hard disk is real damage. Forcing the people inside a large
company to waste thousands of hours cleaning up after a virus is real damage. Even a silly message is
real damage because a person then has to waste the time getting rid of it. For this reason, the legal system
is getting much harsher in punishing the people who create viruses.

Preventing Viruses
You can protect yourself against viruses with a few simple steps:
• If you are truly worried about viruses, you should be running a secure operating system like UNIX
or Windows NT. You never hear about viruses on these operating systems because the security
features keep viruses (and unwanted human visitors) away from your hard disk.
• If you are using an unsecured operating system, then buying virus protection software is a nice
safeguard.
• If you simply avoid programs from unknown sources like the Internet, and instead stick with
commercial software purchased on CDs, you eliminate almost all of the risk. In addition you should
disable floppy disk booting - most computers now allow you to do this, and that will eliminate the
risk of a boot sector virus coming in from a floppy disk accidentally left in the drive.
• You should make sure that Macro Virus Protection is enabled in all Microsoft applications, and you
should NEVER run macros in a document unless you know what they do. No normal person adds
macros to a document, so avoiding all macros is a great policy.
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Open the Options dialog from the Tools menu in Microsoft Word and make sure that Macro Virus
Protection is enabled, as shown

By following those simple steps, you can remain virus free!
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
WORKING WITH VDU'S

INTRODUCTION
This leaflet is a guide for people who work with visual display units (VDUs), and their employers. It:
Answers questions that are most often asked about VDUs and health;
Gives a summary of the law on VDU work (the Health and Safety (Display Screen Equipment) Regulations
1992). Outlines what employers and employees should do to comply; suggests some simple adjustments
that users can make to workstations and screens to make them more comfortable and easy to use; and
explains how employers and users can get further advice
What's the difference between a VDU, a VDT, a monitor and display screen equipment (DSE)?
There isn't one. All these terms mean the same thing - a display screen, usually forming part of a computer
and showing text, numbers or graphics.
This booklet gives advice on health and safety in working with such screens. It covers both conventional
(cathode ray tubes, TV-style) screens and the newer flat-panel displays such as those used in portable
computers.
The advice in this booklet applies to the whole workstation, job and work environment, as well as to the
VDU, keyboard and other equipment.

DOES MY VDU AFFECT MY HEALTH?
Answers to some common questions from VDU users
Am I at risk?
VDUs have been blamed - often wrongly - for a wide range of health problems. In fact, only a small
proportion of VDU users actually suffers ill health as a result of their work. Where problems do occur, they
are generally caused by the way in which VDUs are being used, rather than the VDUs themselves. So
problems can be avoided by good workplace and job design, and by the way you use your VDU and
workstation.
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Are aches and pains caused by using a VDU? What about RSI?
Some users may get aches and pains in their hands, wrists, arms, neck, shoulders or back, especially after
long periods of uninterrupted VDU work. Repetitive strain injury (RSI) has become a popular term for these
aches, pains and disorders, but can be misleading - it means different things to different people. A better
medical name for this whole group of conditions is upper limb disorders. Usually these disorders do not
last, but in a few cases they may become persistent or even disabling.
How can I avoid these aches, pains and disorders?
Problems of this kind may have a physical cause, but may also be more likely if a VDU user feels stressed
by the work (see next question). If you get aches or pains you should alert your supervisor or line manager.
Problems can often be avoided by good workplace design, so that you can work comfortably, and by good
working practices (like taking frequent short breaks from the VDU). Prevention is easiest if action is taken
early, before the problem has become serious. For more about how to avoid trouble, see Making
adjustments to suit your needs..
What can be done to reduce stress in my VDU work?
People who use a VDU sometimes complain of stress, but this usually arises from increased pace of work
or pressure to meet deadlines, not the VDU itself. Some VDU workers find stress reduced because the
VDU makes their job easier or more interesting, but for others stress becomes worse. This can happen
when a system does not work well or when the user does not feel in control or competent to operate it.
Employers can help overcome stress by providing the right training, and by designing systems and tasks to
match the abilities of the people who work with them.
Can work with VDUs affect eyesight?
Extensive research has found no evidence that VDUs can cause disease or permanent damage to
eyes. But long spells of VDU work can lead to tired eyes and discomfort. Also, by giving your eyes more
demanding tasks, it might make you aware of an eyesight problem you had not noticed before. You and
your employer can help your eyes by ensuring your VDU is well positioned and properly adjusted, and that
the workplace lighting is suitable. Ask for an eye test if you still think there is a problem.
What about problems with my contact lenses or bifocals?
The heat generated by VDUs can make the air seem drier, and some contact lens wearers find this
uncomfortable. If you have this problem but don't want to change to spectacles, you can try blinking more
often or using tear-substitute drops. Where the air is dry, employers can help by taking steps to increase
the humidity.
People with bifocal spectacles may find them less than ideal for VDU work. It is important to be able to
see the screen easily without having to raise or lower your head. If you can't work comfortably with
bifocals, you may need a different type of spectacles. Consult your optician or doctor if in doubt.
Can VDU work cause headaches?
Headaches may result from several things that occur with VDU work, such as:
•
•
•
•
•
•
•
•

screen glare;
poor image quality;
a need for different spectacles;
stress from the pace of work;
anxiety about new technology;
reading the screen for long periods without a break;
poor posture; or
a combination of these.

Many of these things can easily be put right once the cause of the problem has been found.
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How long should I work with a VDU?
There is no legal limit, but you need to break up long spells of VDU work. How long you should work
without a break depends on the type of work you are doing. See Plan work so there are breaks or
changes of activity and Posture and breaks for further information.
Do VDUs give out harmful radiation?
No. VDUs give out both visible light, which enables us to see the screen, and other forms of
electromagnetic radiation which can be harmful above certain levels. However, the levels of radiation
emitted from VDUs are well below the safe levels set out in international recommendations. So your
employer doesn't have to check radiation levels from your VDU, and you do not need any special devices
such as spectacles, screens or aprons when using it.
What should I do if I'm pregnant?
You don't need to stop working with VDUs. Past concern, about reports of miscarriages and birth defects
among some groups of VDU workers, has not been borne out by more recent research. Many scientific
studies have now been carried out and, taken as a whole, these do not show any link between
miscarriages or birth defects and working with VDUs.
If you are anxious about your VDU or about work generally during pregnancy, you should talk to your
doctor. Or you could talk to someone who is well informed about current scientific information and advice
on VDUs.
Can working with VDUs cause skin disorders?
This is rare. A few people have experienced irritation, rashes or other skin problems when working with a
VDU. The exact cause is not known, but it seems possible that a combination of dry air, static electricity
and individual susceptibility may be involved. If this is the case, increasing the humidity or allowing more
fresh air into the room may help.
Can VDUs trigger epileptic fits?
Most people with epilepsy are completely unaffected by VDUs. A few who suffer from photo-sensitive
epilepsy and are susceptible to flickering lights and striped patterns may be affected in some
circumstances. But even they can often work successfully with VDUs without provoking an attack.
I use a portable computer - are there any precautions I should take?
Laptops and other portable computers have to be compact enough to be easy to carry. This result in
design compromises, like smaller keyboards and screens, which make portables less comfortable in
prolonged use than a normal VDU.
It is best to avoid using a portable for long periods when full-sized equipment is available. And like other
VDU users, people who habitually use a portable should be trained how to minimise risks. This includes
sitting comfortably, angling the screen so it can be seen clearly with minimal reflections, and taking
frequent breaks if work is prolonged. Wherever possible, portables should be placed on a firm surface at
the right height for keying.
Is it true that using a mouse can cause problems?
Intensive use of a mouse, trackball, or similar pointing device may give rise to aches and pains in the
fingers, hands, wrists, arms or shoulders. This can also happen with a keyboard, but mouse work
concentrates activity on one hand and arm (and one or two fingers), and this may make problems more
likely.
Risks can be reduced by adopting a good posture and technique - see using a mouse.
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Make the most of opportunities to take breaks from intensive mouse work - even short pauses can help, as
can spells doing keyboard or non-computer work. If you use a mouse a lot, you can try changing from right
to left-handed use (and vice-versa) from time to time. It can also help to take your hand off the mouse
during short pauses and let your mouse arm hang straight down from your shoulder. If you find gripping
your mouse awkward, you could try a different shaped or sized one.

THE REGULATIONS AND HOW THEY AFFECT YOU
The Health and Safety (Display Screen Equipment) Regulations 1992 came into effect from January 1993
to implement an EC Directive. They require employers to minimise the risks in VDU work by ensuring that
workplaces and jobs are well designed.
Who is affected?
The Regulations apply where staff habitually uses VDUs as a significant part of their normal work. Other
people, who use VDUs only occasionally, are not covered by these Regulations, but their employers still
have general duties to protect them under other health and safety at work legislation.
I am self-employed - am I covered?
The Regulations do not place any duties on the self-employed. However, parts of them apply if you
habitually use a VDU for a significant part of your normal work and are using a client employer's
workstation. The client employer has to assess and reduce risks, ensure the workstation complies with the
minimum requirements and provide information, as if you were an employee. But there is no requirement
for employers to plan work breaks, or to provide eye tests or training for the self-employed.
I work at home - am I covered?
Yes, the Regulations apply if you are an employee working at home, and habitually using a VDU for a
significant part of your normal work.

WHAT DO EMPLOYERS HAVE TO DO TO COMPLY?
The Regulations do not contain detailed technical specifications or lists of approved equipment. Instead,
they set more general objectives.
Employers have to:
Analyse workstations, and assess and reduce risks
Employers need to look at:
•
•
•

the whole workstation including equipment, furniture, and the work environment;
the job being done; and
any special needs of individual staff (whose views may be sought as part of the assessment).

Where risks are identified, the employer must take steps to reduce them.
Ensure workstations meet minimum requirements
These requirements are good features that should normally be found in a workstation, such as adjustable
chairs and suitable lighting. They are set out in a schedule to the Regulations, covering screens,
keyboards, desks, chairs, the work environment and software. All workstations covered by the Regulations
now have to comply, to the extent necessary for the health and safety of workers (a transitional period for
modification of older workstations expired at the end of 1996).
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Plan work so there are breaks or changes of activity
As the need for breaks depends on the nature and intensity of the work, the Regulations require breaks or
changes of activity but do not specify their timing or length. However the guidance on the Regulations
explains general principles, for example short, frequent breaks are better than longer, less frequent ones.
Ideally the individual should have some discretion over when to take breaks.
On request arrange eye tests, and provide spectacles if special ones are needed
Employees covered by the Regulations can ask their employer to provide and pay for an eye and eyesight
test. This is a test by an optometrist or doctor. There is also entitlement to further tests at regular intervals;
the optometrist doing the first test can recommend when the next should be. Employers only have to pay
for spectacles if special ones (for example, prescribed for the distance at which the screen is viewed) are
needed and normal ones cannot be used.
Provide health and safety training and information
Employers have to provide training, to make sure employees can use their VDU and workstation safely,
and know how to make best use of it to avoid health problems, for example by adjusting the chair.
Information should also be provided about VDU health and safety. This should include general
background information - this could be done by giving out copies of this booklet. It should also cover
more specific details of the steps taken by the employer to comply with the Regulations, such as the
action taken to reduce risks and the arrangements for breaks.
Details of more comprehensive HSE guidance publications on the Regulations are given later.

MAKING ADJUSTMENTS TO SUIT YOUR NEEDS
What can I do to help myself?
Make full use of the equipment provided, and adjust it to get the best from it and to avoid potential health
problems. If the Regulations apply to you, your employer should cover these things in training. If the
Regulations don't apply, it is still worth setting up your workstation properly, to be as comfortable as
possible. Here are some practical tips:
Getting comfortable

•
•
•

Adjust your chair and VDU to find the most comfortable position for your work. As a broad guide, your
forearms should be approximately horizontal and your eyes the same height as the top of the VDU.
Make sure you have enough workspace to take whatever documents or other equipment you need.
Try different arrangements of keyboard, screen, mouse and documents to find the best arrangement
for you. A document holder may help you avoid awkward neck and eye movements.
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•
•

Arrange your desk and VDU to avoid glare, or bright reflections on the screen. This will be easiest if
neither you nor the screen is directly facing windows or bright lights. Adjust curtains or blinds to
prevent unwanted light.
Make sure there is space under your desk to move your legs freely. Move any obstacles such as
boxes or equipment. Avoid excess pressure from the edge of your seat on the backs of your legs and
knees. A footrest may be helpful, particularly for smaller users.

Keying in
•
•

Adjust your keyboard to get a good keying position. A space in front of the keyboard is sometimes
helpful for resting the hands and wrists when not keying.
Try to keep your wrists straight when keying. Keep a soft touch on the keys and don't overstretch your
fingers. Good keyboard technique is important.

Using a mouse
•
•
•

Position the mouse within easy reach, so it can be used with the wrist straight. Sit upright and close to
the desk, so you don't have to work with your mouse arm stretched. Move the keyboard out of the way
if it is not being used.
Support your forearm on the desk, and don't grip the mouse too tightly.
Rest your fingers lightly on the buttons and do not press them hard.

Reading the screen
•
•
•
•

Adjust the brightness and contrast controls on the screen to suit lighting conditions in the room.
Make sure the screen surface is clean.
In setting up software, choose options giving text that is large enough to read easily on your screen,
when you are sitting in a normal, comfortable working position. Select colours that are easy on the eye
(avoid red text on a blue background, or vice-versa).
Individual characters on the screen should be sharply focused and should not flicker or move. If they
do, the VDU may need servicing or adjustment.

Posture and breaks
•
•

Don't sit in the same position for long periods. Make sure you change your posture as often as
practicable. Some movement is desirable, but avoid repeated stretching to reach things you need (if
this happens a lot, rearrange your workstation).
Most jobs provide opportunities to take a break from the screen, eg to do filing or photocopying. Make
use of them. If there are no such natural breaks in your job, your employer should plan for you to have
rest breaks. Frequent short breaks are better than fewer long ones.

MORE INFORMATION AND ADVICE
The Health and Safety Executive (HSE) has published two other guidance booklets giving detailed
information on the Display Screen Equipment Regulations. Employers in particular may wish to consult one
of them. The two booklets are:
•

VDUs: An easy guide to the Regulations
HSG90 HSE Books 1994 ISBN 0 7176 0735 6
This is the booklet HSE recommends for most employers who have staff using standard VDUs in
offices. It gives practical guidance, in plain language, on how to comply with the Regulations with a
minimum of effort and expense. It is illustrated in colour and includes a checklist for workstation
assessment.
Note: additional copies of the checklist are available in priced packs of 10,
ISBN 0 7176 0804 2.

 Grimsby College

115

•

Display screen equipment work. Health and Safety (Display Screen Equipment) Regulations
1992. Guidance on Regulations
L26 HSE Books ISBN 0 7176 0410 1
This booklet in HSE's Legal series gives comprehensive guidance on interpretation of each part of the
Regulations. It includes the text of the Regulations themselves. It will be of most interest to employers
who need to check the detail of particular requirements, or anyone who wants advice on application of
the Regulations to display screen equipment other than ordinary VDUs in offices.

All these publications are available from HSE Books (see below) or booksellers.
What should I do if I have any problems?
If you are a VDU user and think you have health problems connected with your work, it's best to talk to
your supervisor, manager or safety representative first. Employers have a duty to consult their employees
or employee representatives on health and safety issues.
If this doesn't help, VDU users and employers can get advice from the relevant authority:
•
•

For VDU work in an office, shop or hotel: contact the Environmental Health Department at your local
council.
For other premises (and government offices): contact your nearest local office of the Health and Safety
Executive, as listed in the telephone directory.

This leaflet is available in priced packs of 10 from HSE Books, ISBN 0 7176 1504 9. Single free copies are
also available from HSE Books.
HSE priced and free publications are available by mail order from:
HSE Books,
PO Box 1999,
Sudbury,
Suffolk CO10 6FS
Tel: 01787 881165 Fax: 01787 313995
HSE priced publications are also available from good booksellers.
For other enquiries ring HSE's InfoLine Tel: 0541 545500, or write to HSE's Information Centre, Broad
Lane, Sheffield S3 7HQ
This leaflet contains notes on good practice which are not compulsory but which you may find helpful
in considering what you may need to do.
THIS GUIDE HAS BEEN COPIED FROM THE HEALTH AND SAFETY EXECUTIVE WEB SITE
HTTP://WWW.OPEN.GOV.UK/HSE/HSEHOME.HTM
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KEY SKILLS
INFORMATION TECHNOLOGY – LEVEL 2
REPETITIVE STRAIN INJURIES (RSI)
CAUSES OF REPETITIVE STRAIN INJURIES
Repetitive strain injuries (RSI) are a category of injuries involving damage to muscles, tendons and
nerves caused by overuse or misuse. Any combination of the following factors can lead to the overuse of
some part of your body.
•
•
•
•

Repetitive tasks – Small, rapid movements and/or tasks that are repeated over and over
Awkward or fixed postures – Working in an awkward position or holding the same position for a long
time
Forceful movements – Using force or moving heavy loads to complete tasks
Insufficient rest time – No time to relax during the above activities

Unlike strains and sprains, which usually result from a single incident (called acute trauma), repetitive
strain injuries develop slowly over time; thus, they are also called Cumulative Trauma Disorders (CTDs).
Other names for these injuries include Repetitive Stress Injury, Repetitive Motion Syndrome and
Occupational Overuse Syndrome.
SYMPTOMS OF RSI
The most common body parts affected by RSI are the fingers, hands, wrists, elbows, arms, shoulders,
back and neck. Other areas can be affected as well. Computer users suffer mostly from repetitive strain
injuries to the hand, wrist, and arm.
The symptoms of RSI include: aching, tenderness, swelling, pains, crackling, tingling, numbness, loss of
strength, loss of joint movement and decreased co-ordination in the injured area. If your hands are
affected, you may find yourself dropping things or it may be difficult to do even simple tasks like buttoning a
shirt.
These symptoms may appear in any order and at any stage in the development of an injury. Symptoms
may not appear immediately after the activity that is causing the problem and are not necessarily
experienced in the body part where the actual stress is occurring. For instance, if you wake up in the
middle of the night with elbow or shoulder pain, that may be a sign of a repetitive strain injury resulting from
keying or mousing at a computer.
In general, the more intense the symptoms, the more often you experience symptoms and the longer
symptoms last, the more serious your injury is likely to be. A serious injury can develop only weeks after
symptoms appear, or it may take years.
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COMMON RSI
To understand the various repetitive strain injuries you need a basic understanding of how your body
works. Contracting and relaxing muscles produce body movements. The muscles are attached to bones by
tendons. Tendons are smooth and in some parts of your body glide back and forth inside tubes called
synovial sheaths.
The sheath produces a lubricant called synovial fluid to help the tendons glide easily. (See Figures 1 and
2)

Figure 1
For example, the muscles in your forearm are used to move your fingers. They are attached to the finger
bones by tendons in sheaths that travel through your wrist. The type of injury resulting from keying or
mousing at a computer depends on whether the muscle, tendon, tendon sheath, or nerve tissue have been
irritated or damaged.
•

Tendentious refers to the inflammation of tendons that occurs when muscles and tendons are
repeatedly tensed. Symptoms may include pain and swelling. Eventually, the tendon becomes bumpy
and fibres may fray. Or the tendon may thicken, making movement of the fingers, hands or arms
difficult. Without sufficient time to heal, the tendon may be permanently weakened.

•

Tenosynovitis refers to the inflammation of the synovial sheath caused by repetitive motion. It usually
occurs in the hands and wrists (although it can also occur in the legs, elbows and shoulders). This
injury can be quite painful and tendon movement may become restricted due to the swelling of the
sheath. If the sheath or tendon becomes scarred, Tenosynovitis can cause permanent damage.

•

Ganglionic Cysts are another tendon sheath condition. The sheath swells up with synovial fluid and
causes a bump under the skin, often on the wrist. Ganglionic cysts may be a symptom of
Tenosynovitis.

•

Carpal Tunnel Syndrome (CTS) is one of the most potentially disabling RSI. Nine tendons for flexing
your fingers, along with the median nerve, pass from the forearm to the hand through a passage in
your wrist called the carpal tunnel. The tunnel is made up of bone and ligament (flexor retinaculum).
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Figure 2
CTS result when the median nerve is compressed, either from the swelling of tendons and sheaths or
from repeated bending of the wrist. Symptoms include numbness, tingling, and pain in the side of your
hand that goes from the thumb to the inside of your ring finger. Often the pain is worse when sleeping.
Advanced symptoms include weakness, especially in the thumb muscle, and clumsiness in your
hands.
Other repetitive strain injuries to the upper body include De Quervian's Disease, Trigger Finger,
Epicondylitis (tennis elbow), and Thoracic Outlet Syndrome.
RSI AND WORKING AT THE COMPUTER
These conditions, when present during computer use, can lead to RSI:
•
•
•

Repetition – Long or concentrated hours of keying or mousing, especially if under pressure to key
quickly
Posture – Long hours of sitting in the same position while keying or mousing -- especially if in an
uncomfortable or poorly supported position or if your wrists are bent
No Rest – Intensive hours at the keyboard with few breaks, especially if the task has little variety or if
you don't take a rest when you need one

Remember that a computer keyboard requires only light touches, letting you type very quickly, and that
typing at a computer affords no natural variation in movement as working at a typewriter used to do.
RSI FROM NON-WORK ACTIVITY
RSI can be caused by activities, which are not work-related. These include hand-intensive sports and
hobbies such as knitting or playing a musical instrument. The risk of developing an RSI can also be related
to certain medical conditions such as bone fractures, rheumatoid arthritis, hypertension, diabetes, obesity,
pregnancy and use of oral contraceptives. Older workers are more at risk because the body's ability to
repair from constant wear and tear decreases with age.
RSI CAN BE PREVENTED
If symptoms are allowed to progress, a person with RSI can have protracted or chronic symptoms.
However, RSI can be prevented. Don't wait until it's too late.
YOUR COMPUTER WORKSTATION: PERSONAL CHECKLIST OF ERGONOMIC FEATURES
Use the following checklist and the illustration to evaluate your posture, computer workstation design, and
job design. If you answer "yes" to each question, then your workstation and job are probably well designed
ergonomically. If you answer "no" or are unsure of your answers to any of the questions, then you should
take steps to correct situations that may increase the risk of developing repetitive strain injuries.
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Posture (when working at the computer)
Are your feet resting fully and firmly on the floor or footrest?
Are your knees bent at approximately right angles?
Are your thighs parallel to the floor, so that the chair does not put pressure on the back of your thighs?
Is your upper body straight, with your lower back firmly supported by the chair backrest?
Are your upper arms hanging straight down at your sides?
Are your elbows against your sides and bent at right angles?
Are your forearms parallel to the floor?
Are your wrists straight, neither bent up or down nor to the left or right?
Is your head looking forward with only a slight downward tilt?
Chair
Is your chair adjustable for seat height? If not adjustable, is the chair height right for you?
If your chair is adjustable, do you know how to adjust it?
Does the backrest give firm support on your lower back?
Is the front edge of the seat rounded to avoid pressure on the back of your thighs?
Does the chair have casters that roll easily on the floor?
Do you have a footrest, if you need one, on which to rest your feet?
NOTE: Chair armrests are optional. If used, they should be padded, not hard.
The Keyboard and Mouse
Is the keyboard detached from the monitor?
Can the keyboard height be adjusted?
Is the keyboard at the right height so that your elbows are at your sides, forearms parallel to the floor, and
your wrists are straight?
Is the keyboard thin and level with the floor?
Is the keyboard on a foam pad to soften the impact of your fingers on the keys?
Are the springs in the keys stiff enough to resist the weight of your fingers when relaxed?
Do the keys give tactile (you can feel key pressure decrease when the character is registered) or audible
(you hear a click when character is registered) feedback to stop you from pressing too hard?
Can your fingers reach the shift and function keys without awkward straining?
Are you able to keep your typing speed under 10,000 keystrokes per hour?
Is the mouse located at the same height as the keyboard and as close to it as possible?
NOTE: Wrist rests are sometimes recommended but may do more harm than good. If used, they should be
well padded and the proper thickness.
The Monitor
Can the monitor height be adjusted?
If the screen is small, is the top of the screen opposite eye level? If the screen is large, is the centre of the
screen opposite eye level?
Is the monitor at the proper viewing distance for you? (The distance is usually 1.5 to 2 feet from your eyes.)
Is the monitor directly in front of you, rather than off to the side?
Do you have a copy stand or document holder to hold the papers you work with?
Are the copy stand and the computer screen at the same height, and at about the same distance from your
eyes?
Is the monitor positioned to avoid glare?
Work Area
Does the desk have a lower surface for the keyboard and higher surface for the monitor (either built-in or
attached)?
Is there enough room for your legs under the desk?
Is there enough space to put the equipment and other materials at the proper distance without crowding?
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Are you able to use the phone without having to squeeze the receiver with your shoulder while you type?
Are standing counters available, if appropriate, so you can alternate sitting and standing while doing
computer work?

Job/Project Design
Do you take short, frequent breaks from computer work? Short rests taken often provide better protection
than longer breaks after longer periods of work.
Do you usually take a break before you feel any muscle fatigue in your upper body?
Do you get up and move around whenever you begin to feel any symptoms?
Do you pause periodically to do relaxation exercises?
Have you adjusted your workstation furniture?
Do you use the same workstation all day so that you only have to make adjustments once a day at most?
Do you have input when your department is purchasing computer equipment and furniture?

A. Measures the distance from the bottom of the heel, when it is flat on the floor, to the underside of the
knee, when it is bent at right angles. Adjust the height of your chair so that your thighs are horizontal,
your knees are at right angles, and your heels are flat on the floor.
B. Measures the distance from the floor to the bottom of the wrist when the arm is parallel to the floor.
Adjust the keyboard height so that your forearms are parallel to the floor and your wrists are flat.
C. Measures the distance from the floor to the eye when you are sitting properly at a computer
workstation. Adjust the monitor screen so that when your eyes are looking straight ahead they are
opposite the top of the screen if it is small, or opposite the middle of the screen if it is large.
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